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Spirograf 
Cod 260500 
Descriere Spirometru de diagnosticare utilizat pentru a 
măsura debitul de aer şi a volumelor rezultate din 
manevrele 
de spirometrie de bază (de exemplu, capacitatea vitală 
forţată [SVI], fluxul de vîrf [PF], volumul expirator 
forţat întro secundă [FEV1]). 
Parametrul Specificația 
Tip Spirometru portabil 
Memorarea automată a celor mai bune 3 rezultate de 
spirometrie da 
Parametri măsurați FVC 
FEV1 
FEV1/FVC 
Raport PEF 
EVC 
IVC 
Ti 
Te 
IC 
IRV 
ERV 
TV 
Printer intern 
Memorie nu mai puțin de 300 teste grafice memorate 
Transfer date la PC teste pacient 
verificare aparat 232200up-gradare software 
Dispozitivul de măsură bidirecțional 
Diapazonul de volum ≥ 0-8 l 
Diapazonul de flux ≥ 0-16 l/s 
Eroarea la volum ≤3% 
Eroarea la flux ≤3% 
Afișaj Alfanumeric 
Control taste alfanumerice 
Interfața PC da 
Alimentare Cu sursă internă de alimentare, 
acumulatoare reîncărcabile 
Rețeaua electrică 220 V, 50 Hz 
Accesorii 
Să fie inclus toate consumabilele necesare pentru 200 
investigații "filtre antibacteriale sau turbine de 
unică utilizare" 
Seringă de calibrare da, (doar în cazul dacă este 
necesară) 
Clește pentru nas tip adult 1 buc. 
Clește pentru nas tip pediatric 1 buc. 
Hîrtie 20 buc. 
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a măsura debitul de aer şi a volumelor rezultate din 
manevrele de spirometrie de bază (de exemplu, 
capacitatea vitală forţată [SVI], fluxul de vîrf [PF], 
volumul expirator forţat întro secundă [FEV1]). DA 
Parametrul Specificația 
Tip Spirometru portabil DA pag 2 a broșurii  
Memorarea automată a celor mai bune 3 rezultate de 
spirometrie DA  
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FEV1 DA 
FEV1/FVC DA 
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EVC DA 
IVC DA 
Ti DA 
Te DA 
IC DA 
IRV DA 
ERV DA 
TV DA 
Printer intern DA 
Memorie nu mai puțin de 300 teste grafice memorate 
DA 
Transfer date la PC teste pacient DA 
verificare aparat upgradare software DA 
Dispozitivul de măsură bidirectional DA 
Diapazonul de volum ≥ 0-8 l DA 
Diapazonul de flux ≥ 0-16 l/s DA  
Eroarea la volum ≤3% DA 
Eroarea la flux ≤3% DA 
Afișaj Alfanumeric DA 
Control taste alfanumerice DA 
Interfața PC DA  
Alimentare Cu sursă internă de alimentare,  DA 
acumulatoare reîncărcabile DA 
Rețeaua electrică 220 V, 50 Hz DA 
Accesorii DA 
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unică utilizare" DA 
Seringă de calibrare da, (doar în cazul dacă este 
necesară) DA 
Clește pentru nas tip adult 1 buc. DA 
Clește pentru nas tip pediatric 1 buc. DA 
Hîrtie 20 buc. DA   
 

 





Pony FX is the new generation family 
of portable spirometers from COSMED, 
representing the ideal solution for Eexible 
lung function screening in many Delds of 
application. 

Pony FX design allows easy spirometry testing 
without sacriDcing anything to functionality. 

Two diCerent Pony FX models are currently 
available: 

Pony FX: desktop spirometer with COSMED vali-
dated digital bidirectional turbine Eowmeter.

Pony FX MIP/MEP: desktop spirometer with 
digital turbine and included module for respi-
ratory mechanics measurements (MIP/MEP) 

Design
 ■ High quality color LCD display for real 

time testing

 ■ Integrated 120 mm high speed thermal 
printer for high quality reports in few 
seconds

 ■ Compact size and light weight

 ■ Alphanumeric keyboard and navigator 
tool to allow user access to all functions

 ■ Internal memory of up to 600 tests/
patients

 ■ New Li-Ion battery with autonomy of up 
to 6 hours

 ■ Easy interface with PC and other devices 
through the ports: USB-A, USB-B, RS 232

Spirometry
 ■ Full spirometry (FVC, SVC, MVV, Pre/post 

BD)

 ■ New Trial Selection and Quality Control 
functions (in compliance with ATS/ERS 
guidelines)

 ■ Innovative pediatric incentivation with 
selectable eCort grade

 ■ Full compliance with “2005 ATS/ERS 
consensus” (Interpretation, QC, etc.)

 ■ GOLD COPD interpretation on FVC 
PostBD 

 ■ Includes latest Global Lung Initiative 
(GLI) predicteds (including Z-score)

 ■ ATS, Metacholine-dose, Mannitol and 
user deDned bronchochallenge protocols

 ■ Possibility to download Six Minute Walk 
Test data from any Spiropalm 6MWT

Respiratory Mechanics (MIP/MEP) 
 ■ Measurement of respiratory muscle 

strength

 ■ Easy to perform, quick, non-invasive

 ■ Either for healthy subjects or patients 
with pulmonary/neuromuscular 
diseases

 ■ Special mouth pressuremeter

 ■ Complies with ATS/ERS Guidelines

Data Management & Software
Spirometry tests can be also performed real-
time with Pony FX connected to a PC through 
the powerful software OMNIA. 

 ■ Innovative user interface, touch screen, 
easy and self-explanatory

 ■ Graphical data presentation both at 
screen and on printouts with gauges 
(pictograms)

 ■ Powerful algorithm automatically elabo-
rates results and provides comprehen-
sive interpretation text strings including 
numerical results 

 ■ Full customizable time-based trends of 
main measured parameters 

 ■ Access and security compliant to inter-
national regulations

 ■ Multi-device management (single 
license for multiple products)

 ■ Advanced network capabilities 
(Optional). Running on SQL database.

 Full spirometry testing (FVC, SVC, 
MVV, Pre/Post BD)

 Respiratory Mechanics assesment 
(MIP/MEP)

 Airway resistance by Occlusion 
Technique (option)

 Oxygen saturimetry with integrated 
SpO

2
 monitor (option)

 Colour LCD display with real time 
graphs and embedded high speed 
thermal printer

 Validated turbine flowmeter

 Provided with OMNIA software for 
data management, real time testing 
and interpretation on PC

(1) Crapo R. O. (LDS Hospital) 2004 “Validation of COSMED 
turbine vs ATS 24 standard volume-time waveforms“

Turbine 6owmeter with AB 5lter 
for Spirometry testing

Pressure Transducer with AB 5lter 
for MIP/MEP testing

 The COSMED Pony FX meets ATS recommendations for accuracy and precision in measuring FVC, FEV1 , FEF25-75% 
and peak expiratory -ow under ambient and BTPS conditions(1)



Options & Accessories
 ■ Respiratory resistance by interrupter technique 

(Rint, Rocc). Ideal solution for testing 
children (requires low patient collabo-
ration) and good alternative to body 
plethysmography for airway resistance. 
Test is performed during tidal breathing 
through, a dedicated low Eow PNT 
mouthpiece while an occlusion valve 
interrupts the airEow for 100 msec 

 ■ Pulse oximetry (SpO
2
). Oxygen desaturation 

and heart rate measurement with high 
quality integrated monitor (Nonin© 
technology). Low power draw and intel-
ligent pulse-by-pulse Dltering.

Advanced software for data management, real time testing and 
interpretation directly on PC

Pony FX screenshot: real-time MIP/MEP

Pony FX screenshot: real-time SpO2

Pony FX screenshot: real-time Rocc

Thermal printout sample (original size 110mm wide): 
Forced Vital Capacity (FVC)

Pony FX screenshot: real-time FVC



©
 20

21
/0

3-
a  

   C
OS

M
ED

    
 E 

& 
OE

. S
ub

jec
t t

o a
lte

ra
tio

ns
 w

ith
ou

t p
rio

r n
ot

ice
.   

  R
EF

 C0
90

62
-0

2-
93

Maggiori info:

GERMANY

COSMED Deutschland GmbH 
Werneck 
+49 (0)8684942900 
DE@cosmed.com

FRANCE

COSMED France SASU 
Brignais 
+33 (0)4 478628053 
FR@cosmed.com

THE NETHERLANDS

COSMED Benelux BV  
Nieuwegein 
+31 (0) 88 10 50 500 
BNL@cosmed.com 

DENMARK

COSMED Nordic ApS 
Odense 
+45 6595 9100 
DK@cosmed.com 

SWITZERLAND

COSMED Switzerland GmbH 
Fehraltorf 
+41 (0)43 50 869 83 
CH@cosmed.com

USA

COSMED USA, Inc. 
Concord, Chicago 
+1 800 4263763 Toll Free 
USA@cosmed.com

AUSTRALIA

COSMED Asia-Paci5c Pty Ltd 
Artarmon 
+61 449 971 170  
ANZ@cosmed.com 

HONG KONG

COSMED HK Ltd 
Kowloon 
+852 3708 3126 
HK@cosmed.com 

Headquarters 
ITALY

COSMED Srl 
Rome 
+39 06 931-5492 
info@cosmed.com

COSMED Srl

Via dei Piani di Monte Savello 37 
Albano Laziale - Rome 00041 
Italy 
+39 (06) 931-5492 Phone 
+39 (06) 931-4580 Fax

cosmed.com

ScientiDc studies at: www.cosmed.com/bibliography

To know more

Distributed by



Cosmed does not assume the liability for interpretation mistakes of this 
documentation or for casual or consequential damages in connection with the 
provision, representation or use of this documentation.

No parts of this manual may be reproduced or transmitted in any form without 
the express permission of COSMED Srl.

COSMED Software can be installed only in one device.

Excel is a registered trademark of Microsoft Corporation.
DBIII is a registered trademark of Bordland International Inc.
Lotus 123 is a registered trademark of Lotus Development Corporation .

Pony FX User manual, V Edition 

03/2005 

Copyright © 2003 COSMED

Copyright © 2004 COSMED

COSMED Srl - Italy 
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Important notices 

Intended use 

Pony FX is an electrical medical device designed to perform
pulmonary function tests. It is to be used by physicians or by
trained personnel on a physician responsibility.

Caution: Federal law restricts this device to sale by or on the
order of a physician.

This equipment has been conceived with the aim of providing an
auxiliary instrument  allowing:

• the formulation of lung pathology diagnosis;

• important studies concerning human physiology;

• the collection of important information in sport medicine.

No responsibility attaches COSMED Srl for any accident
happened after a wrong use of the device, such as:

• use by non qualified people;

• non respect of the device intended use;

• non respect of the hereunder reported precautions and
instructions.

Warnings 

The device, the program algorithms and the presentation of
measured data have been developed according to the
specifications of ATS (American Thoracic Society) and ERS
(European Respiratory Society). Other international references
have been followed when these were not available. All
bibliography references are reported in Appendix.

The present handbook has been developed with respect of the
European Medical Device Directive requirements which sort
Pony FX within Class II a.

It is recommended to read carefully the following precautions
before putting the device into operation.

The precautions reported below are of fundamental importance to 
assure the safety of all COSMED equipment users.

1. This user manual is to be considered as a part of the medical 
device and should always be kept on hand.

2. Safety, measure accuracy and precision can be assured only:
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• using the accessories described in the manual or given
with the device. Actually non recommended accessories can
affect safety unfavourable. Before using non recommended
accessories it is necessary to get in touch with the
manufacturer;

• ordinary equipment maintenance, inspections,
disinfection and cleaning are performed in the way and with
the frequency described;

• any modification or fixing is carried out by qualified
personnel;

• the environmental conditions and the electrical plants
where the device operates are in compliance with the
specifications of the manual and the present regulations
concerning electrical plants. In particular grounding
reliability and leakage current suppression can only be
assured when the device three – wire receptacle is connected 
to a yellow - green return connected to earth ground.
Attempting to defeat the proper connection of the ground
wire is dangerous for users and equipment.

3. Before powering the system, check the power cables and the
plugs. Damaged electrical parts must be replaced
immediately by authorised personnel.

4. Cleaning residue, particulates, and other contaminates
(including pieces of torn or broken components) in the
breathing circuit pose a safety risk to the patient during
testing procedures. Aspiration of contaminates can
potentially be life-threatening. Use disposable anti-bacterial
filters or disinfect each part in contact with the patient before 
each test.

5. You must follow all the cleaning procedures in System
Maintenance, and you must thoroughly inspect the
components after cleaning and before each patient test.

6. This device is not suitable for use in presence of flammable
anaesthetics. It is not an AP nor an APG device (according to 
the EN 60 601-1 definitions).

7. Keep the device away from heat and flame source,
flammable or inflammable liquids or gases and explosive
atmospheres.

8. In accordance with their intended use Pony FX is not to be
handled together with other medical devices unless it is
clearly declared by the manufacturer itself.
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9. It is recommended to use a computer with electromagnetic
compatibility CE marking and with low radiation emission
displays.

10. It is necessary to make the PC, connected to the  Pony FX,
compliant with EN 60601-1 by means of an isolation
transformer.

11. The Pony FX needs special precautions regarding EMC and
needs to be installed and put into service according to the
EMC information provided in the section EMC.

12. Portable and mobile RF communications equipment can
affect the Pony FX.

13. Use only the cable and accessories supplied with the
equipment. The use of accessories and/or cables other than
those supplied may result in increased emissions or
decreased immunity of the equipment.

14. The Pony FX should not be used adjacent to or stacked with
other equipment. If adjacent or stacked use is necessary, the
Pony FX should be observed to verify normal operation in
the configuration in which it will be used.

15. Graphical symbols used in accordance to present
specifications are described here below:

Equipment type B (EN60601-1)

Equipment type BF (EN60601-1)

Danger: high temperature

OFF

ON

Protective earth ground

Alternating current
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Contraindications 

The physical strain to execute the respiratory manoeuvre is
contraindicated in case of some symptoms or pathology. The
following list is not complete and must be considered as a piece
of mere information.

Contraindications for the Spirometer tests 

Absolute contraindications 

For FVC, VC and MVV tests:

• Post-operating state from thoracic surgery

For FVC tests:

• Severe instability of the airways (such as a destructive
bronchial emphysema)

• Bronchial non-specific marked hypersensitivity

• Serious problems for the gas exchange (total or partial
respiratory insufficiency)

Relative contraindications 

For FVC tests:

• spontaneous post-pneumothorax state

• arterial-venous aneurysm

• strong arterial hypertension

• pregnancy with complications at the 3rd month.

For MVV test:

• hyperventilation syndrome

Contraindications for Bronchial provocation tests 

The bronchial provocation tests must be executed according to
the doctor’s discretion. There are not data that reveal specific
contraindication for the bronchial provocation test through
inhalation.

The modern standard processes have been revealing secure in
several clinical studies. However it is recommendable to respect
the following contraindications:
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Absolute contraindications 

• Serious bronchial obstruction (FEV1 in adults)

• Recent myocardium infarct

• Recent vascular-cerebral accident

• Known arterial aneurysm

• Incapacity for understanding the provocation test procedures
and its implications.

Relative contraindications 

• Bronchial obstruction caused by the respiratory manoeuvre.

• Moderate or serious bronchial obstruction. For ex. FEV1 <
1.51 in men and FEV1 in women < than 1.21.

• Recent infection in the superior air tracts

• During the asthmatic re-acuting

• Hypertension

• Pregnancy

• A pharmacology treatment epilepsy
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Environmental condition of use 

COSMED units have been conceived for operating in medically
utilised rooms without potential explosion hazards.

The units should not be installed in vicinity of x-ray equipment,
motors or transformers with high installed power rating since
electric or magnetic interferences may falsify the result of
measurements or make them impossible. Due to this the vicinity
of power lines is to be avoided as well.

Cosmed equipment are not AP not APG devices (according to
EN 60601-1): they are not suitable for use in presence of
flammable anaesthetic mixtures with air, oxygen or nitrogen
protoxide.

If not otherwise stated in the shipping documents, Cosmed
equipment have been conceived for operating under normal
environmental temperatures and conditions [IEC 601-1(1988)/EN
60 601-1 (1990)].

• Temperature range 10°C (50°F) and 40°C (104°F).

• Relative humidity range 20% to 80%

• Atmospheric Pressure range 700 to 1060 mBar

• Avoid to use it in presence of noxious fumes or dusty
environment and near heat sources.

• Do not place near heat sources.

• Cardiopulmonary resuscitation emergency equipment
accessible.

• Adequate floor space to assure access to the patient during
exercise testing.

• Adequate ventilation in the room.
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EMC 

Guidance and manufacturer’s declaration - electromagnetic emissions 

The Pony FX is intended for use in the electromagnetic environment specified below. The customer or 
the user of the Pony FX should assure that it is used in such an environment.

Emissions test Compliance Electromagnetic environment - guidance 

RF emissions

CISPR 11

Group 1 The Pony FX uses RF energy only for its internal
function. Therefore, its RF emissions are very low
and are not likely to cause any interference in nearby 
electronic equipment.

RF emissions

CISPR 11

Class B

Harmonic Emission

IEC 61000-3-2

Class A

Voltage Fluctuations / Flicker 
Emission

IEC 61000-3-3

Complies

The Pony FX is suitable for use in all establishments, 
including domestic establishments and those directly 
connected to the public low-voltage power supply
network that supplies buildings used for domestic
purposes.
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Guidance and manufacturer’s declaration - electromagnetic immunity 

The Pony FX is intended for use in the electromagnetic environment specified below. The customer 
or the user of the Pony FX should assure that it is used in such an environment.

Immunity test Test level Compliance level Electromagnetic environment - 

guidance 

Electrostatic
discharge (ESD)

IEC 61000-4-2

±6 kV contact

±8 kV air

±6 kV contact

±8 kV air

Floors should be wood, concrete or 
ceramic tile. If floors are covered
with synthetic material, the relative 
humidity should be at least 30%.

Electrical fast 
transient/burst

IEC 61000-4-4

±2 kV for power 
supply lines

±1 kV for 
input/output lines

±2 kV for power 
supply lines

±1 kV for 
input/output lines

Mains power quality should be that 
of a typical commercial or hospital 
environment.

Surge

IEC 61000-4-5

±1 kV differential 
mode

±2 kV common 
mode

±1 kV differential 
mode

±2 kV common 
mode

Mains power quality should be that 
of a typical commercial or hospital 
environment.

Voltage dips, short
interruptions and
voltage variations
on power supply
input lines

IEC 61000-4-11

<5% UT

(>95% dip in UT)
for 0.5 cycles

40% UT

(60% dip in UT) for 
5 cycles

70% UT

(30% dip in UT) for 
25 cycles

<5% UT

(>95% dip in UT)
for 5 sec

<5% UT

(>95% dip in UT)
for 0.5 cycles

40% UT

(60% dip in UT) for 
5 cycles

70% UT

(30% dip in UT) for 
25 cycles

<5% UT

(>95% dip in UT)
for 5 sec

Mains power quality should be that 
of a typical commercial or hospital 
environment. If the user of the
Pony FX requires continued
operation during power mains
interruptions, it is recommended
that the Pony FX be powered from 
an uninterruptible power supply or
a battery.

Power frequency 
(50/60 Hz) 
magnetic field

IEC 61000-4-8

3 A/m 3 A/m Power frequency magnetic fields
should be at levels characteristic of 
a typical location in a typical
commercial or hospital
environment.

Note: UT is the a.c. mains voltage prior to application of the test level.
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Guidance and manufacturer’s declaration - electromagnetic immunity

The Pony FX is intended for use in the electromagnetic environment specified below. The customer
or the user of the Pony FX should assure that it is used in such an environment.

Immunity test Test level Compliance 

level 

Electromagnetic environment - guidance 

Conducted RF

IEC 61000-4-6

Radiated RF

IEC 61000-4-3

3 Veff

150 kHz to
80 MHz

3 V/m

80 MHz to
2.5 GHz

3 V

3 V/m

Portable and mobile RF communications
equipment should be used no closer to any part
of the Pony FX, including cables, than the
recommended separation distance calculated
from the equation applicable to the frequency of 
the transmitter

Recommended separation distance 

d=1.17 P

d=1.17 P  80 MHz to 800 MHz

d=2.33 P  800 MHz to 2.5 GHz

where P is the maximum output power rating of 
the transmitter in watts (W) according to the
transmitter manufacturer and d is the
recommended separation distance in metres (m).

Field strengths from fixed RF transmitters, as
determined by an electromagnetic site surveya,
should be less than the compliance level in each 
frequency rangeb.

Interference may occur in the vicinity of
equipment marked with the following symbol:

Notes:

(1) At 80 MHz, the higher frequency range applies.

(2) These guidelines may not apply in all situations. Electromagnetic propagation is affected by
absorption and reflection from structures, objects and people.

a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless)
telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast 
cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due 
to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured
field strength in the location in which the Pony FX is used exceeds the applicable RF compliance 
level above, the Pony FX should be observed to verify normal operation. If abnormal
performance is observed, additional measures may be necessary, such as reorienting or relocating 
the Pony FX.

b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
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Recommended separation distances between portable and mobile RF communications 

equipment and the Pony FX 

The Pony FX is intended for use in an environment in which radiated RF disturbances are controlled. 
The customer or the user of the Pony FX can help prevent electromagnetic interference by
maintaining a minimum distance between portable and mobile RF communications equipment
(transmitters) and the Pony FX as recommended below, according to the maximum output power of
the communications equipment..

Rated maximum output 

power of transmitter 

(W) 

Separation distance according to frequency of transmitter 

(m) 

 150 kHz to 80 MHz 

d=1.17 P

80 MHz to 800 MHz  

d=1.17 P  

800 MHz to 2.5 GHz  

d=2.33 P  

0.01 0.12 0.12 0.23

0.1 0.37 0.37 0.74

1 1.17 1.17 2.33

10 3.70 3.70 7.38

100 11.70 11.70 23.33

For transmitters rated at a maximum output power not listed above, the recommended separation
distance d in metres (m) can be determined using the equation applicable to the frequency of the
transmitter, where P is the maximum output power rating of the transmitter in watts (W) according to 
the transmitter manufacturer.

Notes:

(1) At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

(2) These guidelines may not apply in all situations. Electromagnetic propagation is affected by
absorption and reflection from structures, objects and people.
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Safety and conformity 

Safety 

IEC 601-1 (1988) /EN 60 601-1 (1990);

Find reported below the complete classification of the device:

• Internally powered equipment type BF device (used stand
alone), class II type BF device (used connected to mains)

• Protection against water penetration: IP41

• Non sterile device

• Device not suitable in the presence of flammable
anaesthetics;

• Continuous functioning equipment;

EMC 

The system meets the EMC Directive 89/336

EN 60601-1-2

EN 55011 Class B (emission), IEC 1000-4-2, IEC 1000-4-3, IEC 
1000-4-4

Quality Assurance 

UNI EN ISO 9001:2000 (Registration n° 387-A Cermet)

Medical Device Directive (CE mark) 

MDD 93/42/EEC (Notified Body 0476).

Class IIa
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Keynotes 

Here are the keynotes used to make the manual easier to read.

Typographic keynotes 

These are the typographic keynotes used in the manual.

Style Description 

Bold indicates a control or a key to be pressed.

“Italic” indicates a messages shown by the firmware.

Graphic keynotes 

These are the graphic keynotes used in the manual.

Illustration Description 

shows the button to click in the software to
activate the related feature.
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Systems Overview 

Pony FX is a device designed for lung function screening; the
core of the system is the “intelligent” flowmeter, connected to the 
main unit, with graphical colour display. It can be considered a
complete portable spirometric laboratory.

Pony FX can be connected to a PC in order to transfer and store
the performed tests, to view the tests and, if it is used the medical 
grade battery charger, to perform the tests and display them on
the PC monitor.

The system is composed by the turbine flowmeter, the
measurement and data elaboration device, the communication
cable, the battery charger and by the Software pack.
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Before starting 

Before operating the Pony FX system we strongly recommend to
check the equipment and register you as a customer.

Checking the packing contents 

Make sure that the package contains the items listed below. In
case of missing or damaged parts, please contact Cosmed
technical assistance.

Pony FX standard packaging 

Code  Qty Description 

C00962-01-04 1 Pony FX Unit

C02235-01-05 1 Turbine

C02364-01-05 1 Reader

A 362 100 001 1 Turbine cable

A 662 100 001 2 Nose clips

C01788-02-36 1 PC Software

C00137-01-20 20 Paediatric paper mouthpieces

C00136-01-20 20 Adult paper mouthpieces

C00063-01-20 1 Conic mouthpiece

C00214-01-20 1 Paediatric mouthpiece adapter

A 362 315 001 1 USB cable

A 182 300 004 5 Bacterial filter

C02383-01-05 1 Pony FX battery charger

A 196 056 001 2 Thermic paper

C00067-02-94 1 Registration card

C01999-02-DC 1 Conformity declaration

C02361-04-91 1 User Manual
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Warranty registration 

Before using the system, please take a moment to fill in the
registration form and the warranty and return them to COSMED,
by doing this you are eligible to the customers assistance service.

For further information, please refer to the enclosed registration
and warranty form. If the form is not enclosed in the packaging,
please contact directly COSMED.

Register the product via software 

Together with the PC software, a registration software is
supplied. With this software it is possible to fill in an electronic
form with the customer information.

1. To run the software, double click on the icon Registration or 
select Registration… from ? menu.

2. Type the requested information and click Send… to send the 
form via e-mail to COSMED.

How to contact COSMED 

For any information you may need, please contact the
manufacturer directly at the following address:

COSMED S.r.l.

Via dei Piani di Monte Savello, 37
P.O. Box n. 3
00040 - Pavona di Albano
Rome - ITALY

Voice: +39 (06) 931.5492
Fax: +39 (06) 931.4580
email: customersupport@cosmed.it 

Internet: http: //www.cosmed.it 

Complain, feedback and suggestions 

If you have any complain, feedback information or suggestion,
please inform us at complain@cosmed.it.



 Chapter 1 - Getting started - 25 

PC configuration required 

• Pentium II 350 MHz.

• Windows 98, XP.

• 64 Mb RAM .

• CD drive.

• VGA, SVGA monitor.

• USB or RS232 port.

• Any Mouse and Printer compatible with the MS Windows™
operative system.

• PC conform to European Directive 89/336 EMC

If you use an external printer, it must support the PCL language
and have an USB port for data transmission.

The USB connection works properly only with Windows XP.
Otherwise, use the serial RS232 connection.
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Technical features 

Flowmeter Bidirectional digital turbine 
(standard), disposable 
pneumotachograph (option)

Flow Range: 0.03 - 20 l/s

Volume Range: 12 l

Accuracy: ± 3% or 50 ml

Resistance @12 l/s: < 0.7 cmH2O/l/sec

Mouthpieces: Ø 31 and Ø22 mm

Internal temperature sensor: 0-50°C (32-122°F)

Dimensions: 198 x 238 x 76 mm

Weight: 1.2 kg

Supply: 4 Ni-Mh rechargeable batteries 
1.3V, 2300 mAh, no memory 
effect

Power supply AC/DC 220/110 VAC in, 12 VDC 1A out
(class II according to EN 60 601-1 standard)

Interface RS232, USB-A, USB-B (for the 
external printer)

LCD 320x240 STN colour backlighted

In-built printer Thermo sensitive, 832 pixel per
line

Printer paper 112 cm, standard sensibility, 
good stability , image duration 15 
years



 

Measurements 
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Measured parameters 

FVC - Forced Vital Capacity 

Symbol UM Parameter 

FVC l Forced Expiratory Vital Capacity

FEV1 l Forced Expiratory Volume in 1 sec

FEV1/FVC% % FEV1 as a percentage of FVC

PEF l/sec Peak Expiratory Flow

FEV0.5 l Forced Expiratory Volume in 0.5 sec

FEV6 l Forced Expiratory Volume in 6 sec

FEV1/FEV6 % FEV1 as a percentage of FEV6

FEV6/FVC% % FEV6 as a percentage of FVC

Best FVC l Best Forced Expiratory Vital Capacity

Best FEV1 l Best Forced Expiratory Volume in 1 sec

Best PEF l/sec Best Peak Expiratory Flow

Vmax25% l/sec Expiratory Flow @25% of the FVC

Vmax50% l/sec Expiratory Flow @50% of the FVC

Vmax75% l/sec Expiratory Flow @75% of the FVC

FEF25-75% l/sec Mid-exp flow between 25-75%FVC

FET100% sec Forced expiratory time

FEV2 l Forced Expiratory Volume in 2 sec

FEV3 l Forced Expiratory Volume in 3 sec

FEV2/FVC% % FEV2 as a percentage of FVC

FEV3/FVC% % FEV3 as a percentage of FVC

FEV1/VC% % Tiffenau index

FEF50-75% l/sec Mid-exp flow between 50-75%FVC

FEF75-85% l/sec Mid-exp flow between 75-85%FVC

FEF0.2-1.2% l/sec Mid-exp flow between 0.2 l - 1.2 l

FiVC L Inspiratory Forced Vital Capacity

FiF25-75% l/sec Forced mid-inspiratory flow

FiV1 l/sec Forced Inspiratory Volume in 1 sec

PIF l/sec Peak Inspiratory Flow

VEXT ml Extrapolated Volume (back extrapolation)

PEFT msec Time to PEF (10% - 90%)

▲▲▲ 
Note: Some 
parameters are 
computed only by 
the PC software. 
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VC/IVC - Slow Vital Capacity and Ventilatory pattern 

Symbol UM Parameter 

EVC l Expiratory Vital Capacity

IVC l Inspiratory Vital Capacity

ERV l Expiratory Reserve Volume

IRV l Inspiratory Reserve Volume

IC l Inspiratory Capacity

VE l/min Expiratory Minute Ventilation

Vt l Tidal Volume

Rf 1/min Respiratory Frequency

Ti sec Duration of Inspiration

Te sec Duration of Expiration

Ttot sec Duration of Total breathing cycle

Ti/Ttot —- Ti/Ttot ratio

Vt/ti l/sec Vt/ti ratio

MVV - Maximum Voluntary Ventilation 

Symbol UM Parameter 

MVV l/min Maximum Voluntary Ventilation

MVt l Tidal Volume (during MVV)

MRf 1/min Maximum Respiratory frequency

MVVt sec MVV duration time

Bronchoprovocation Response 

Symbol UM Parameter 

FallFEV1 % Fall in FEV1 from baseline or post diluent

FallVmax50% % Fall in Vmax50% from ref.

P10 —- Provocative dose causing FEV1 to fall 10%

P15 —- Provocative dose causing FEV1 to fall 15%

P20 —- Provocative dose causing FEV1 to fall 20%
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Installation 
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Preparing Pony FX 

Pony FX is mainly made of:

• Pony FX unit

• Battery charger

• Flowmeter (pneumotachograph or turbine, depending on the
version)

Let us see an overview of the parts and their assembly.

Pony FX unit 

The main elements a user can detect in the Pony FX unit are the
following:

• A colour display

• A keyboard

• An internal printer

• Some connectors on the bottom side of the device.

The display 

The colour display interfaces the device with the user, allowing
the user to access to the functions of the device and to display the 
performed tests.

The keyboard 

Pony FX has a keyboard (see the next picture), which allows the
user to interact with the device.
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The keyboard is divided into two groups. In the left one there are 
the on/off-menu key (at the centre) and four direction keys.

In the right group there are 10 alphanumeric keys, the confirm
and the delete keys.

A more detailed description of the keys functions, of the
keyboard logics and of the menus, see the chapter Using Pony 

FX.

The printer 

It is a thermal printer, which allows the printing of the test
performed.

For more information about the use of the internal (or an
external) printer, see the chapter Using Pony FX.

The connectors 

On the bottom side of the device there are 7 connectors, as shown 
in the following picture.

A label details the connection type:
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From the left to the right, in order:

• 2 pneumatic connectors for pneumotachograph, if you do not 
use the turbine flowmeter.

• Connector for the RS232 cable, if the PC doesn’t have an
USB port, or for the oxymeter (option).

• Connector for the turbine flowmeter or for the airway
resistance measurement module (option).

• USB connector for the PC.

• USB connector for an external printer.

• Battery charger connector.

Replacement of the power plug 

If the power plug does not fit into the mains socket, replace it
with the one in the packaging.

In order to replace the plug:

1. Extract the plug from the battery charger

2. Insert the proper plug in the battery charger.

Battery charger 

Pony FX is powered by a battery pack, rechargeable by means of
a battery charger.

Connect the battery charger to the Pony FX unit through the
connector with the symbol by side.

Near the keyboard, a led indicates the battery status:

Green led In charge

Orange led Full charged

Red led Error.

The red led can be due to:

• Battery temperature <5°C. The red led should switch off
when the temperature falls again in the range 5-45°C.

• Battery temperature >45°C. The red led should switch off
when the temperature falls again in the range 5-45°C.
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• Very low battery, because of the unit has been not used for a 
long time. The led switches to green after some time of
charging. Please fully charge the unit.

• Failed battery. Please contact the technical support.

Note: The first time you use the device, charge the battery for at 

least 12 hours, even if the led indicates the completion of the 

charge before the time elapsed. 

Note: The batteries must be replaced when they do not maintain 

their charge for enough time. Please contact the technical support. 

Connect the flowmeter to the Pony FX 

The turbine flowmeter is made of a
handle (the reader) with a hole, in
which it is placed the turbine.

The air passing through the helical
conveyors, takes a spiral motion
which causes the rotation of the
turbine rotor. The rolling blade
interrupts the infrared light beamed
by the two diodes of the reader.
Every interruption represents 1/4
turn of the rotor, this allows to
measure the number of turn in the
time.

It is connected to the unit through
the Turb./Raw connector.

For hygienic reasons, we strongly
recommend the use of a bacterial
filter, to be connected as in the
picture by side.

Note: While inserting the turbine, be sure to push the turbine up 

to touch the end of the reader. 
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Connect the ROCC module (option) to the Pony FX 

1. Connect the three parts of the ROCC  module as in the picture 
by side.

2. Connect the module to the Pony FX unit through the
Turb./Raw connector.

Connect the oxymeter (option) to the Pony FX 

It is connected to the unit through the RS232/SpO2 connector.

Connect the Pony FX to the PC 

The Pony FX can be connected to the PC in order to transfer and 
store the performed tests, to back-up the data on a different unit
(HD, floppy, CD ROM), to analyse the tests or to perform the
tests sending the controls directly from the PC.

If the PC connected to the Pony FX is placed within the patient
area (according to the IEC 60601-1-1 norm), the PC has to be
made compliant with the IEC 60601-1-1 norm by means of an
isolation transformer.

The PC is connected to the Pony FX unit, through an USB
connection, to the USB port with the symbol by side.

If the PC does not have an USB port, it is possible to use a
RS232 serial connection.

Select the communication port both on the PC (selecting the
menu item Options/Configure) and on the unit (selecting the
menu item 2.Options/1.Settings).

The first time you connect the Pony FX to the PC through an
USB connection, you will be requested for the drivers. Install
them from the installation CD.

1. Occlusion valve 
2. Reader 
3. PNT 
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Connect the Pony FX to an external printer 

The Pony FX can be directly connected to an external printer in
order to print the performed tests on a different paper.

If the printer connected to the Pony FX is placed within the
patient area (according to the IEC 60601-1-1 norm), it has to be
made compliant with the IEC 60601-1-1 norm by means of an
isolation transformer.

The printer is connected to the Pony FX unit, through an USB
connection, to the USB port with the symbol by side.
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Software installation 

Installing the software 

1. Select Run... from Windows Start menu.

2. Insert the disk in the proper drive.

3. In the Command line, type <name of the drive>:\install.

4. Click on OK (or press ENTER key).

5. The program will load up a dialog box and ask for a
directory where to be installed.

6. When the installation is over, the program will advise you
with a message indicating that the installation has been
successfully completed, click on End.

Notice: The software is copy-protected. Install the software from 

the original disk. 

Run the software 

1. In the Windows Start menu, open the Program Group in
which the software was installed.

2. Click the PFT Suite icon.

PC port configuration 

The first time the software is used, it is necessary to configure the 
communication port with the PC (USB, COM1, COM2,…).

For further details, see the chapter Database management.
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Software main features 

Display 

The program may contain several windows. The active window
is highlighted with a different colour of the caption. Some
functions of the program are "active window" sensitive (Print,
right key of the mouse).

Tool bar 

Many of the functions that may be selected from the menu can be 
activated more rapidly by clicking with the mouse on the
corresponding icon in the tool bar.

Positioning the mouse cursor on one of the buttons of the toolbar 
(if the option Hints is enabled), the description of the
corresponding function is shown in a label.

Show/hide the toolbar 

Select Toolbar from Options menu in order to show or hide the
toolbar.

Dialog windows 

The typical operating environment of Microsoft Windows is the
Dialog box. This window is provided with a series of fields in
which input the information.

Use of the keyboard 

• To move the cursor among fields, press the Tab key until
you reach the desired field.

• Press the Enter key to confirm the information input on the
dialog box or press the Esc key to cancel changes.

Use of the mouse 

• To move the cursor among fields, move the mouse on the
desired field and left-click.

• Click on the OK button with the Left button of the mouse to 
confirm the information input on the dialog box or click on
Cancel button to cancel changes.
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Scroll bars 

Some windows are provided with scroll bars that help to see data 
exceeding the window space available.

• To move the scroll bar row by row click the scroll arrows at
the end of the scroll bars

• To move the scroll bar page by page click on the grey area at 
both  sides of the scroll fields

On-line help 

COSMED Help is a complete on-line reference tool that  you can 
use at any time. Help is especially useful when you need
information quickly or when the user manual is not available.
Help contains a description of each command and dialog  box,
and explains many procedures for accomplishing common tasks.

To get the Help on line, press the F1 key.

Software version 

To know the software version and the serial number of the
software, select About… from Help menu.



 

Calibration 
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The calibration program 

Running the Calibration program 

Start the program and choose Calibration from the Test Menu.
The software runs the Calibration software and the main menu
changes accordingly.

Log file 

The program creates and updates as default the calibration log
file, containing the conditions and the results of all the
calibrations performed by the user.

To access the file select File/Report File... from the calibration
program.
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Turbine calibration 

Pony FX is calibrated by COSMED. ATS recommends a daily
calibration of the turbine. However if it is correctly maintained,
turbine retains its precision for longer periods. We advice to
calibrate the turbine daily to detect malfunctioning.

Note: if you are using a slow PC, we recommend to set an higher 

refresh time. 

Calibrating the turbine without a PC 

In order to calibrate the turbine by means of the Pony FX unit:

1. Connect the turbine flowmeter to the calibration syringe.

2. Select the menu item 3.Utilities/1.Calibration.

3. Move the piston in and out for 10 strokes (IN and EX).

The 3 litres calibration syringe can be purchased directly from
COSMED (P/N: C00600-01-11).

Note: If a bacterial filter is used for the tests, do use it also 

during the turbine calibration. 

Calibrating the turbine by means of a PC 

In order to calibrate the turbine by means of the PC software:

1. Connect the turbine flowmeter to the calibration syringe.

2. Select Calibration from Test menu.

3. Select Reference values from the Calibration menu and
enter the syringe volume, if different to the displayed one. 

4. Select Turbine from the Calibration menu.

5. When the Calibration Turbine dialog box appears with the
syringe piston initially pushed all the way in, move the
piston in and out for 5 inspiratory strokes and 5 expiratory
strokes in order to get the first values appearing on the
screen. Then move the syringe piston for other 10 strokes
(IN and EX).

6. At each of the 10 steps the software displays the results of
the manoeuvre and the percentage error in the reading.
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7. At the end of this operation, the software displays the new
calibration factors. Press OK to store the new value.

The 3 litres calibration syringe can be purchased directly from
COSMED (P/N: C00600-01-11).

Note: If a bacterial filter is used for the tests, do use it also 

during the turbine calibration. 
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Checking the system signals 

The control panel 

The Control Panel, which can be activated from the
Calibration/Control panel… menu item, is a useful tool to
check the main hardware functions of Pony FX.

By using the controls on Control Panel you are able to read the
signals acquired by the system both as voltages and processed
data.

Using the control panel 

mV / real values 
display 

Select all 
channels 

Deselect all 
channels 

Signal refresh 
time 

edit parameters 
(name, unit,…) 
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Using Pony FX 
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Main functions of the Pony FX 

All the Pony’s functions are controlled by means of the keyboard 
(see the following picture).

Turning on/off the Pony FX 

In order to turn on or off the device, hold the MENU key pressed
for few seconds.

Pony FX has two automatic turning-off functions:

• of the display. If you don’t use the unit for at least the time
set in configuration (see later, Options), the display turns off
automatically. In order to avoid this, press any key.

• of the device. If you don’t use the unit for at least 5 minutes, 
the unit turns off automatically. In order to turn on the
device, press the MENU key.

Using the menu 

The menu bar is displayed in the upper part of the screen, and it
appears different, depending on the context.

In the lower part of the display, a status bar indicates useful
information and short Help messages.

Accessing the menu 

You can access the menu in two ways:

• Press shortly the MENU key, and then change menu by
means of the direction keys. Confirm the selected item by
means of the key        .
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• Press the key on the alphanumeric keyboard corresponding
to the selected menu item, until the desired function is
highlighted.

The two methods (direction keys and alphanumeric keyboard) are 
fully interchangeable.

To exit the menu, press the MENU key.

Using the keyboard 

Please find in the following a brief description of the functions of 
the keys, and then a description of the keyboard logic.

Key Description 

Turns on/off the Pony FX, accesses the menus.

Goes to the upper menu item or (in input data
mode) to the previous field.

Goes to the lower menu item or (in input data

mode) to the next field.

Goes to the menu item on the right. In input data
mode, adds a blank space to the right or (in multi-
options fields) scrolls forwards the available

options.

Goes to the menu item on the left. In input data
mode, deletes the last character entered or (in
multi-options fields) scrolls backwards the
available options.

Enters the digit 1 or a character . , ; : # @ - = ! ? $ 

& / ( )

Enters the digit 2 or a character A B C

, , , , , , as the  key

Enters the digit 0

Cancels the operation.

Confirms the operation or the selected menu item.
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Logic of the keyboard 

The logic of the keyboard follows these rules:

• If the current input field (the one with the cursor) allows an
alphanumeric input (for example, name, company,…), you
have to follow these instructions in order to enter the
characters:

⇒ A repeated pressure of a key scrolls the available
characters for that key until another key is pressed or it
elapses 1 second.

⇒ If you wait more than 1 second or if you press another
key, you confirm the input and the cursor moves 1 place
towards right.

For example, in order to enter the string “BB4” you have to
press the following keys:

 <wait> 

The keys will enter the character first (letter or signs), and
then the digit.

• Pressing the Left key, the cursor moves towards left, deleting 
the characters.

For some fields, you have to select an option from a
predefined list. In these cases, this key allows scrolling
backwards the list.

• Pressing the Right key, the cursor moves towards right,
adding blank spaces.

For some fields, you have to select an option from a
predefined list. In these cases, this key allows scrolling
forwards the list.



 Chapter 5 - Using Pony FX - 51 

Patient database management 

Create a new patient 

In order to create a new patient, select the menu item
1.Patients/1.New and enter the required data.

In the following you will find some useful notes for proper data
entry.

• ID is an alphanumeric sequence, which identifies the patient. 
It is assigned automatically by the unit, but can be modified
as you want. The maximum length is 16 chars.

• The birth date must be entered as month-day-year. The year
must be four-digit format.

• The height has to be entered in the two fields: the first one
for metres, the second one for centimetres.
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Search a patient in archive 

In order to search a patient stored in the archive, select the menu
item 1.Patients/2.View/Search. It will open a window with the
patient list.

Scroll the list by means of the arrows and confirm the selected
patient with the key by side.

If necessary, cancel the operation with the key by side.



 Chapter 5 - Using Pony FX - 53 

Performing the spirometric tests 

Once completed the phase of the introduction of the patient’s
data (or selection of an already archived patient), it is possible to 
carry out the spirometric tests.

For a complete description of the tests and of the measured
parameters, see the chapter Spirometry.

Recommendations for spirometry tests 

• The patient should wear the nose clip

• The turbine has been recently calibrated (ATS recommends a 
daily calibration)

• If you are using the pneumotachograph, do not breathe into
the flowmeter, until the proper message appears.

• The paper mouthpiece or the antibacterial filter is properly
connected to the flowmeter through the corresponding
adapter

For hygienic reasons, we strongly recommend the use of a
bacterial filter.

If a kid must perform the test it is recommended to enable the
encouragement function which shows exactly the manoeuvre of
the FVC test.

Forced Vital Capacity (pre) 

1. Explain the manoeuvre to the patient (breathe at rest for
some time, perform a maximal inspiration and then a
maximal forced exhalation).

2. Select the menu item 1.Test/1.FVC Pre.

3. Wait until the program is ready for the test.

4. After having performed the test, press 2.Stop or wait for the
automatic end (5 seconds without flow), so that the device
displays the F/V graph, the main parameters, and the
predicteds values.

5. Press 0.Abort in order to abort the test and discard the
results. Press 1.Redo in order to restart the test.

6. Repeat the test until it is correctly performed (ATS
recommends 3 times) , by pressing 1.Redo.

7. The three best tests will be displayed superimposed each to
the other, identified by different colours. On the right side of

▲▲▲ 
Note: Read 
carefully the 
contraindications 
in Chapter 1. 
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the display, the three best tests, their colours and the
measured parameters are reported, ordered from the best to
the worst. The best and the last test performed are
highlighted.

8. Press 2.Save & Exit in order to exit saving a test. You will
be ask to select the test to store: press the digit corresponding 
to the test to be stored. 

9. Otherwise, press 0.Exit without saving in order to exit the
test mode without saving the tests.

Test encouragement 

During FVC manoeuvre you might experience some lack of
collaboration with kids or with other patients. In this case you
may find a good help in using the encouragement tool.

1. Select the menu item 1.Test/6.Encouragement.

2. Perform the test as described in the previous paragraph.

Slow Vital Capacity 

1. Explain the manoeuvre to the patient (breathe at rest for
some time, perform a maximal inspiration, then a slow
forced exhalation, and finally a deep inspiration).

2. Select the menu item 1.Test/4.SVC.

3. Wait until the program is ready for the test.

4. After having performed the test, press 2.Stop or wait for the
automatic end (5 seconds without flow), so that the device
displays the V/T graph, the main parameters, and the
predicteds values.

5. Press 0.Abort in order to abort the test and discard the
results. Press 1.Redo in order to restart the test.

6. Repeat the test until it is correctly performed (ATS
recommends 3 times), by pressing 1.Redo.

7. The three best tests will be displayed superimposed each to
the other, identified by different colours. On the right side of
the display, the three best tests, their colours and the
measured parameters are reported, ordered from the best to
the worst. The best and the last test performed are
highlighted.

8. Press 2.Save & Exit in order to exit saving a test. You will
be ask to select the test to store: press the digit corresponding 
to the test to be stored. 
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9. Otherwise, press 0.Exit without saving in order to exit the
test mode without saving the tests.

Maximum Voluntary Ventilation 

1. Explain the manoeuvre to the patient (breathe as deep and
fast as possible for about 12 seconds).

2. Select the menu item 1.Test/5.MVV.

3. Wait the program is ready for the test.

4. After having performed the test, the device displays the V/T
graph, the main parameters, and the predicteds values.

5. Press 0.Abort in order to abort the test and discard the
results. Press 1.Redo in order to restart the test.

6. Repeat the test until it is correctly performed (ATS
recommends 3 times), by pressing 1.Redo.

7. The three best tests will be displayed superimposed each to
the other, identified by different colours. On the right side of
the display, the three best tests, their colours and the
measured parameters are reported, ordered from the best to
the worst. The best and the last test performed are
highlighted.

8. Press 2.Save & Exit in order to exit saving a test. You will
be ask to select the test to store: press the digit corresponding 
to the test to be stored. 

9. Otherwise, press 0.Exit without saving in order to exit the
test mode without saving the tests.

Bronchial Provocation Test 

The program refers to the FVC pre which is selected
(highlighted) at the test start.

The name of the drug, the quantity and unit of measurement, and, 
only for bronchoconstrictor tests, the delivery protocol, can be
customised from the Utility menu (see later in this document).

Bronchodilators test 

The manoeuvre is identical to the FVC test.

1. Select the menu item 1.Test/2.FVC Post BD.

2. Wait until the program is ready for the test.

3. After having performed the test, press 2.Stop or wait for the
automatic end (5 seconds without flow), so that the device
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displays the V/T graph, the main parameters, and the
predicteds values.

4. Press 0.Abort in order to abort the test and discard the
results. Press 1.Redo in order to restart the test.

5. Repeat the test until it is correctly performed (ATS
recommends 3 times), by pressing 1.Redo.

6. The three best tests will be displayed superimposed each to
the other, identified by different colours. On the right side of
the display, the three best tests, their colours and the
measured parameters are reported, ordered from the best to
the worst. The best and the last test performed are
highlighted.

7. Press 2.Save & Exit in order to exit saving a test. You will
be ask to select the test to store: press the digit corresponding 
to the test to be stored. 

8. Otherwise, press 0.Exit without saving in order to exit the
test mode without saving the tests.

Bronchoconstrictor test 

The manoeuvre is identical to the FVC test.

1. Select the menu item 1.Test/3.FVC Post BC.

2. A window with bronchoconstrictor name, quantity and
measurement unit, as set in 2.Options/3.FVC Post, will be
displayed.

3. If you accept the protocol, confirm, otherwise modify the
values and confirm.

4. Wait until the program is ready for the test.

5. After having performed the test, press 2.Stop or wait for the
automatic end (5 seconds without flow), so that the device
displays the V/T graph, the main parameters, and the
predicteds values.

6. Press 0.Abort in order to abort the test and discard the
results. Press 1.Redo in order to restart the test.

7. Repeat the test until it is correctly performed (ATS
recommends 3 times), by pressing 1.Redo.

8. The three best tests will be displayed superimposed each to
the other, identified by different colours. On the right side of
the display, the three best tests, their colours and the
measured parameters are reported, ordered from the best to
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the worst. The best and the last test performed are
highlighted.

9. Press 2.Save & Exit in order to exit saving a test. You will
be asked to select the test to store: press the digit
corresponding to the test to be stored. 

10. Otherwise, press 0.Exit without saving in order to exit the
test mode without saving the tests.

11. Repeat all the FVC Post until the FEV1 falls down by more
than 20% of the FVC Pre value.
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Performing the oximetry test (option) 

The oximetry test measures the haemoglobin saturation, i.e. the
percentage of the blood haemoglobin bearing oxygen. The test
can be performed at rest or during/after a light exercise phase
(cycling, jogging).

The test is completely automatic.

The measured parameters are:

SpO2 Haemoglobin saturation

HR Heart rate

Recommendations for oximetry tests 

• Be sure that the sensor has been properly disinfected.

• Use only the original COSMED sensor.

• Operation and accuracy of the measurement may be affected
by the following:

− high ambient light

− fingernail polish or artificial fingernail

− excessive motion

Performing the test 

1. Connect the sensor to the Pony FX unit through the
RS232/SpO2 port.

2. Connect the probe to patient’s index finger and affix with
adhesive tape if necessary.

3. Select the menu item 1.Test/7.SpO2.

4. In the first part of the test the HR and SpO2 values, together
with a plethysmographic graph, are displayed. The graph
monitors the quality of the signal.

5. Wait for an acceptable quality of the real-time trace and
verify that the Perfusion indicator is green. Press:

− 1.Rest to store the rest value.

− 2.Exercise to store the exercise value.

− 3.O2 Suppl. to store the value with inspired oxygen
supplement.

It is not necessary to store all the three values during a single 
test.
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Viewing results 

View a test in archive 

After having selected a patient, highlight the desired test by
means of the arrow keys. The graph of the selected test will
appear on the right side of the display.
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Printing results 

Replace the printer paper 

You need thermic paper (P/N A 196 056 001, 10 pcs.).

1. Open the azure paper cover.

2. Lift up the green lever.

3. Insert the paper into the slot with the two light grey stripes
under the green lever.

4. Lift down the green lever.

5. Select the menu item 3.Utility/4.Paper Feed and wait the
paper exit above the green lever. If the paper does not exit,
check that the paper is properly inserted.

6. Close the paper cover.

Printing tests by means of the internal printer 

1. View the desired test.

2. Select the menu item 2.Print/1.Selected Test in order to
print this test. Select the menu item 2.Print/2.Report in
order to print a report for the selected patient.

Printing tests by means of an external printer 

When an external printer is connected through an USB
connection to the Pony FX unit, the test will be printed on the
external printer.

Note: If the printer connected to the Pony FX is placed within the 

patient area (according to the IEC 60601-1-1 norm), it has to be 

made compliant with the IEC 60601-1-1 norm by means of an 

isolation transformer. 

Note: The printer must support the PCL language and have an 

USB port for data transmission. 
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Options 

The Pony FX unit allows the configuration of some options, by
means of the 2.Options menu.

General settings 

Select the menu item 2.Options/1.Settings.

You can set:

• Date and time. The date must be entered as month-day-year.
The year must be expressed in 4-digit format.

• Language.

• Measurement unit (cm/kg or in/lb)

• Amount of time after which the display turns off
automatically, if the unit was not used.

Spirometry options 

Select the menu item 2.Options/2.Spirometry.

You can set:

• The equation set used for the predicteds values calculation.

• If the test quality control visualisation is enabled.

• If the BTPS correction is applied.

• The flowmeter temperature.
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FVC Post options 

Select the menu item 2.Options/3.FVC Post.

You can set:

• Name, measurement unit and quantity of the bronchodilator.

• Reversibility threshold for the airways obstruction (as %
increment of the FEV1).

• Name and measurement unit of the bronchoconstrictor.

• Protocol for the use of the bronchoconstrictor (quantity to be 
delivered to the patient in the steps of the FVC Post test).
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Printout options 

Select the menu item 2.Options/4.Printouts.

You can set:

• If the unit prints the SVC and MVV tests, the test quality
controls and  the automatic interpretation.

• A page header for the printout.

Advanced options 

Select the menu item 2.Options/5.Advanced.
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You can set:

• The flowmeter type (turbine or pneumotachograph).

• The airway resistance option (enabled or not).

• The oximetry option (enabled or not).

• The mode of the spirometer (ATS-ERS Standard or Office 

Spirometer, a simplified and less detailed version).

Environmental data 

Select the menu item 2.Options/6.Environment.

You can set:

• Pressure

• Relative humidity

Restore of initial settings 

Select the menu item 2.Options/7.Defaults.

With this option you can reset the option and restore the original
factory settings.
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Other functions of Pony FX 

There are other general functions, in order to operate at the best.

You can access to these functions by means of the 3.Utilities

menu. 

Calibration 

The calibration procedure allows exact measurements of flows,
volumes and so on, correcting errors due to climatic changes, use 
of the device, wear, etc.

Select the menu item 3.Utilities/1.Calibration.

For further details, see the chapter Calibration.

Control panel 

The control panel allows to monitor the device status.

Select the menu item 3.Utilities/2.Control panel. The display is
divided into 3 zones.

Sensors 

Temperature inside the unit and the flowmeter, and the battery
charge in mV.

Controls 

Pushing the key 1 the Charger relais activates. It simulates
disconnection or connection between unit and battery charger
cable.

Pushing the key 2, the Printer relais activates. It activates or
deactivates the internal printer.

Embedded Printer 

The Heads icon shows if the green lever is lifted or not.

The Paper icon shows if there is paper charged or not.

The Termistor value is the temperature of the printer.

LCD contrast 

In order to modify the contrast of the Pony FX display:

1. Select the menu item 3.Utilities/3.LCD Contrast.

2. Adjust the contrast by means of the right and left arrow keys.

3. Press the confirm key.
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Paper feed 

This function is useful mainly during the paper replacement.

Select the menu item 3.Utilities/4.Paper Feed.

Memory deletion 

It erases all the memory contents.

1. Select the menu item 3.Utilities/5.Erase Memory.

2. Confirm by pressing the key by side.

Firmware version information 

In order to get information about the installed firmware version,
select the menu item 3.Utilities/6.Information.
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Reset 

Reset of the unit 

If the Pony FX does not run its firmware (the program of the unit, 
not the PC software), it can be rebooted by pressing, with a
sharpened tool, a button inside a little hole on the rear side of the 
unit.

With this operation the data will not be lost.

Formatting the unit 

If, for serious reasons, it is needed to erase all the archive and the 
memory of the Pony FX (also the firmware program), it is
possible to format the unit.

Turn on the Pony FX keeping pressed the Cancel key. Release
the Menu key, then the Cancel key.

It will be necessary retransmit the firmware from the PC software 
(selecting, from the Calibration program, the menu item
Calibration/Transmit program…).

Warning: All the memory will be erased, and you’ll are not able 

to retrieve any data or program. 



 

Database 
Management 
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Settings 

The software allows to configure some options selecting
Configure from the Option  menu.

Graphs 

All the graphs visualised and/or printed can be customised in
colours and appearance.

1. Select the desired colours of the curves (5 curves max can be 
overlapped on the same graph).

2. Enable or disable the Grid option.

3. Enable or disable the Show Info Test option.

Interface 

The port used for data transfer between Pony FX and the PC.

If the Pony FX is connected through USB, select USB from the
list, otherwise select the serial port of the PC to which the unit is
connected (COM1, COM2,…).
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Units of measurements 

It is possible to configure the units of measurements, weight and
height, for printing and viewing.

To select the units of measurement click on cm/Kg or in/lb

according to the desired format.

Using extra fields  

The Patient’s database is organised in 3 different cards (Patient
card, Visit Card and Test card.) where it is possible to store the
information about patients and visits .

Besides the standard information, it is possible to customise some 
fields (user free fields), entering and labelling measurements
coming from other devices.

The  customisable free fields are:

• 3 fields in the Patient Card (Patient’s information)

• 3 fields in the Visit Card (information about the visits)

• 3 fields (2 numeric) in the Test card  information about Test)

Customise the fields 

In the group User free fields type the desired text in the 9 fields
available.
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Patient's database 

The Patients database consists of a Patient Card, a Visit Card and 
a Test Card in which are listed all tests performed by the patient.

Select Patients… from the File menu  or press the button by
side.

Patient Card 

It collects all the information of a patient (first name, last name,
date of birth) which remain the same for each visit. For each
patient there is only one Patient Card, which is created the first
time the Patient performs a test. 

To move within the database use the following buttons:

Move to the first patient in the archive

Move to the previous patient in the archive

Move to the next patient in the archive

Move to the last patient in the archive

Find a patient in the archive

Enter a new patient in the archive

Delete current patient from the archive

Edit the current patient card

▲▲▲ 
Note: after having 
deleted a record 
(patient, visit or 
test), it is 
recommended to 
reorganize the 
archive in order to 
free disk space. 
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Visit Card 

It collects all information relative to the visit (diagnosis, visit
description...) and to the patient information subject to change
between one visit and another (height, weight, smoke). Each
patient can be related to several Visit Cards provided they have
been created in different days. Before carrying out any
spirometric test it is necessary to create a new Visit Card or to
open the today’s Visit Card. 

To move within the database use the following buttons:

Move to the first visit in the archive

Move to the previous visit in the archive

Move to the next visit in the archive

Move to the last visit in the archive

Find a visit in the archive

Enter a new visit card in the archive

Delete current visit card from the archive

Edit the current visit card

Test Card 

It contains all the information about the test.

To move within the database use the following buttons:

Delete current test from the archive.

Edit the current test

Import/export a Tests card 

This function allows to import /export a test card with the
respective visit and patient card.

1. Select the patient.

2. Choose the tests to be exported and press the key by side. All 
data will be imported/exported in the XPO file format
(Cosmed proprietary).

Diagnosis Database 

The program allows to manage a diagnosis database, whose
records are composed by a diagnosis ID code and a string of text.
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The report of the visits can be done either by typing the desired
text in the field “Diagnosis” of the Visit Card or, more quickly,
retrieving from the diagnosis database the desired one.

If you want to insert, modify or delete a diagnosis from the
database select Diagnosis Database... from the File menu.
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Receiving data from the unit 

In order to download the tests performed and stored on the Pony
FX unit, please do the following:

1. Connect the unit to the PC (through serial or USB
connection, depending on the settings)

2. Select Receive test… from the Test menu.

3. In the left side of the window, you have the patient list of the 
Pony FX archive, in the right side there is a list of the
patients in the PC archive.

4. You can link the selected patient tests to a patient already
present in the PC archive (Existing) or to a new patient
(New). In this case, it will be created a new patient with the
data stored in the Pony FX unit.

5. Press Existing or New to start the transmission.
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Uploading patient cards to the unit 

In order to upload patient cards from the PC to the Pony FX unit:

1. Connect the unit to the PC (through serial or USB
connection, depending on the settings)

2. Select Upload patients… from the Test menu.

3. Select the desired patient cards to upload

4. Press Upload to start the transmission.
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Archive maintenance 

The software allows to manage files selecting Archive from the
File menu.

It is advisable to perform the archive reorganisation every month, 
in order to free space on the hard disk and/or to correct possible
errors present within the database.

It is possible also that your have no more hard disk space. So,
you have to delete all the data. In this case, it is useful to perform
the initialising.

Reorganise the archive 

1. Select Reorganize archive from the File menu.

2. Wait for the end of the operation before performing any
other function.

Delete the archive 

1. Select Initialize Archive from the File menu.

2. Wait for the end of the operation before performing any
other function.

Backup and restore 

It is strongly recommended to backup files, a warning message
will be displayed monthly. This function allows the user to
restore the data if the PC or the HD will not work anymore.

Backup 

1. Select Backup archive from the File menu.

2. Selecting the destination path with the Browse key or press
New to create a new directory. Press OK to confirm.
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3. In the dialog box it will appear an estimate of the number of
floppy you need in order to back up the archives. Press OK.

Restore 

1. Select Restore archive from the File menu.

2. On the Restore dialog box specify the drive source and press 
OK, a dialog box  will appear indicating all data of the
backup processed.



 

Spirometry 
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Setting spirometry options 

The software allows to configure some options selecting
Configure from the Option  menu.

Spirometry 

Automatic Interpretation 

Pony FX has the function of interpreting each test performed by a 
patient visualising an automatic interpretation. The algorithm has
been calculated basing on “Lung Function Testing: selection of
reference values and interpretative strategies, A.R.R.D. 144/
1991:1202-1218”. The automatic interpretation is calculated at
the end of the FVC if:

• the automatic interpretation option is enabled.

• the patient’s anthropometric data allow the calculation of the 
LLN (Lower Limit of Normal range).

• at least one FVC test has been performed.

To enable/disable the automatic interpretation:

1. Click on Enable Automatic Interpretation.

2. Select the LLN (Lower Limit of Normal Range) criteria
among the ATS (LLN=Pred-0.674*SD), ERS (LLN=Pred-
1.647*SD) or 80%Pred (LLN=Pred*0.8) specifications.
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Quality control 

Pony FX allows a quality  test control. The calculation has been
carried out referring to “Spirometry in the Lung Health Study:
Methods and Quality Control, A.R.R.D. 1991; 143:1215-1223”.
The messages concerning the quality control are shown at the end 
of the test.

To enable/disable the quality control, click on Enable Quality 

Control checkbox.

Parameters manager 

The program allows to calculate a huge number of parameters; it
is advisable, in order to simplify the analysis of the results, to
view, to print and to sort the desired parameters only. Select the
menu item Options/Parameters... 

View 

Move the parameters to view into the Selected parameters list. 

Print 

Move the parameters to print into the Selected parameters list. 

Sort 

Drag the parameter up or down with the mouse. 

Customise 

Add, modify and delete custom parameters.

If it is necessary to restore the default parameters press the button 
in the left corner of the window to initialise the parameters
database.
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Predicted values manager 

The program contains a preset of predicted equations, but the
user is allowed to customise its own predicted sets. Select 
Predicteds... from Options menu.

The window is divided into two forms: Predicteds set and
Formula definition.

Predicteds set 

This form allows the user to manage the set of predicteds. The
following information define a set:

Name: identifies the set and cannot be duplicated; 

Description: free field; 

Age: the adult predicteds start since this age. 

To enter a new set of predicteds click on the New button. The
field Name must be filled and must be unique. To stop without
saving click on the Cancel button. To save the set, click on the
Save button.

To delete a set of predicteds click on the Delete button. If a set is 
deleted, also the associated formulae are deleted.

It is possible to generate a new set of predicteds with the same
attributes and the same formulae of the selected one. To do this
click on the Copy... button and specify a new Name.

To import a set of predicteds click on the Import... button and
select a file of Predicteds files type.

To export a set of predicteds click on the Export... button.
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In the list Set current predicteds choose the current predicteds
for printing and viewing.

Set the current predicted 

Pony FX allows to calculate the predicted values according to the 

following configurable sets:

Adults Paediatrics 

ERS 93 Zapletal
Knudson83 Knudson83
ITS white ITS white
ITS black ITS black
LAM LAM
MC Barcelona MC Barcelona
Nhanes III Nhanes III

Select the desired choice in the group Predicteds.

Formula definition 

This form allows the user to manage the formulae associated to a 
set of predicteds.

Select the set of predicteds from the list Predicteds set.

To insert a new parameter click on the New... button.

The parameter formulae can be:

• calculated according to the predicteds in the list Use the 

predicteds formulae;
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• customised by the user with the option ...or the customised 

formulae.

The Delete button deletes the selected parameter.

The Copy button stores the selected parameter in memory.

The Paste button inserts a new parameter from the one copied. If
the name is not unique, the user is asked whether to specify a
new name or to replace the existing parameter.

Page set-up 

Select Page Setup... from the File menu.

Header All the printouts carried out by the
program are preceded by 3 rows of
customisable header (usually they contain
the name and the address of the Hospital
using the spirometer).

Data Patient and visit information are printed
below the header. These data are reported
on 3 columns and 5 rows. the user may
configure the disposition, change and
eventually cancel the fields, as he prefers.

Margins Configures the print margins from the
borders of the paper. The unit of measure
is decided in Units of measurements.

Footer Configures information at the bottom of
the page.
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Printed file name Defines the automatic name to be
asssigned to the pdf file, if the report will
be printed in this format.

In the example it has been set to create a
filename composed by <date of the test>
followed by <last name> and <first
name>.
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Spirometry tests 

Once completed the phases of the introduction of the patient’s
data and  the visit data, it is possible to carry out the spirometric
tests.

Pony FX allows to perform the following tests:

Key Test 

FVC pre Forced Vital Capacity

FVC post Forced Vital Capacity after bronchial stimulation

SVC Slow Vital Capacity

MVV Maximum Voluntary Ventilation

Before performing any test make sure that:

1. Pony FX is properly connected to your PC and the selected
serial port (COM1, COM2) corresponds to the one
effectively use.

2. The name shown on the status bar corresponds to the patient
who is to carrying out the tests.

3. The today’s visit card exists.

Recommendations for spirometry tests 

• The patient should wear the nose clips

• The turbine has been recently calibrated (ATS recommends a 
daily calibration)

• If you are using the pneumotachograph, do not breathe into
the flowmeter, until the proper message appears.

• The paper mouthpiece or the antibacterial filter is properly
connected to the flowmeter through the corresponding
adapter

For hygienic reasons, we strongly recommend the use of a
bacterial filter.

If a kid must perform the test it is recommended to enable the
encouragement function which  shows exactly the manoeuvre of
the FVC test.

▲▲▲ 
Note: Read 
carefully the 
contraindications 
in Chapter 1. 
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Forced Vital Capacity (pre) 

FVC is a reference test to verify obstructive (airflow limitations)
and restrictive disorders (lung volume limitations). To achieve
good test results it is fundamental a good manoeuvre (quality
control messages, real time plots …)

The main parameters measured during FVC tests are:

FVC Forced Vital Capacity

FEV1 Forced Expiratory Volume in 1 second

FEV1/FVC% FEV1 as a percentage of FVC

PEF Peak Expiratory Flow

FEF25-75% Forced mid-Expiratory Flow

The two representative plots are the Flow/Volume and
Volume/Time loops.

By comparing FVC, FEV1 and FEV1/FVC% values the software 
allows an automatic interpretation concerning the levels of
obstructive and/or restrictive disorders.

Perform a FVC (pre) test 

1. Select Forced Vital Capacity pre from the Test menu and
wait for the green led is prompted on the right side of the
screen.

2. Explain the manoeuvre to the patient and press the F2 key. 

3. Wait some seconds and perform the test.

4. After having performed the test, press F3 or wait for the
automatic end (5 seconds without flow), so that the software
displays the F/V and V/t graphs, the main parameters, and
the predicteds values.

5. In order to visualise the F/V and V/t graph and the main 
parameters press the following  buttons:

view Flow Volume graph

view Volume Time graph

view data of the test

6. Press Alt+F3 to stop the acquisition discarding the results.

7. Repeat the test until it is correctly performed (ATS
recommends 3 times).
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8. Press Exit to visualise the test list carried out during current
session together with the results of the main parameters.

9. Select the test that you want to save (the Best Test according 
to the ATS criteria is highlighted as default) and press OK. 

Test encouragement 

During FVC manoeuvre you might experience some lack of
collaboration with kids or with other patients. In this case you
may find a good help in using the encouragement software tool.

Perform the FVC test with the encouragement  

1. Select Encouragement from View menu.

2. Perform the test as explained in the previous paragraph.
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Slow Vital Capacity 

Important test for assessing COPD (chronic obstructive
pulmonary disease) patients affected by this disease might
present a the Slow Vital Capacity could be higher than the Forced 
one (FVC).

The main parameters measured during SVC tests are:

EVC Expiratory Slow Vital Capacity

IVC Inspiratory Slow Vital Capacity

ERV Expiratory Reserve Volume

IRV Inspiratory Reserve Volume

If the inspiratory/expiratory maximal manoeuvre is preceded by a 
some breaths at tidal volume the software allows to measure the
Respiratory Pattern, represented by the following parameters:

VE Ventilation per minute

Vt Tidal volume

Rf Respiratory frequency

Ttot Breath time

Ti/Ttot Inspiratory time/Ttot

Vt/Ti Vt/Ti

Perform a SVC test 

1. Select Slow Vital Capacity  from the Test menu and wait
for the green led is prompted on the right side of the screen.

2. Press F2 and instruct the Patient to breath normally until the
message “carry out…” is prompted; then ask to perform a
Slow Vital Capacity (deep inhalation, maximal slow
expiration and deep inhalation again).

3. Press F3 or wait for automatic interruption (5 seconds
without flow) in order to visualise the V/t graph together
with the main parameters compared to the predicted values

4. To visualise the V/t graph and the main parameters press the 
follow buttons:

view Volume Time graph

view data of the test

5. Press Alt+F3 to stop the acquisition discarding the results.
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6. Repeat the test until it is correctly performed (ATS
recommends 3 times).

7. Press Exit to visualise the test list carried out during current
session together with the results of the main parameters.

8. Select the test that you want to save (the Best Test according 
to the ATS criteria is highlighted by default) and press OK. 

The reference for the ERV calculation is displayed on the V/T
graph.
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Maximum Voluntary Ventilation 

Test for assessing the maximum ventilatory capacity. In the past,
it was commonly performed during routine PF tests, however its
clinical use declined over the years. Today MVV test is most
commonly performed as part of the exercise tolerance tests,
where it is used as an index of maximum ventilatory capacity.
Test consists in breathing in and out deeply and rapidly for 12, 15 
seconds. The expired volume during this short period is then
extrapolated

The most important measured parameter is the following:

MVV Maximum Voluntary Ventilation

Perform a MVV test 

1. Select Maximum Voluntary Ventilation  from the test

menu and wait for the green led is prompted on the right side 
of the screen.

2. Press F2 and make the Patient  breath as much deeply and
rapidly as possible for at least 12 seconds.

3. Press F3 or wait for automatic interruption (5 seconds
without flow) in order to visualise the V/t graph together
with the main parameters compared to the predicted values

4. To visualise the V/t graph and the main parameters press the 
follow buttons:

view Volume Time graph

view data of the test

5. Press Alt+F3 to stop the acquisition discarding the results.

6. Repeat the test until it is correctly performed (ATS
recommends 3 times).

7. Press Exit to visualise the test list carried out during current
session together with the results of the main parameters.

8. Select the test that you want to save (the Best Test according 
to the ATS criteria is highlighted as default) and press OK. 
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Bronchial Provocation Test 

Bronchodilator test 

Bronchodilators are administered routinely in the PFT laboratory
to determine whether airflow obstruction is reversible.
Bronchodilators increase airway calibre by relaxing airway
smooth muscle.

The test consists of comparing results between the reference FVC 
(FVC PRE) and the FVC POST performed after the
administration of the drug. Increasing value of 13-15% of FEV1, 
respect to the basal value (FVC Pre) is considered as a reversible 
condition.

Main parameters are the following:

DFEV1%pre Change of FEV1 as a percentage of test PRE

DFVC%pre Change of FVC as a percentage of test PRE

DPEF%pre Change of PEF as a percentage of test PRE

Some authors states that the above mentioned parameters are too
dependent from the FVC Pre, hence latest reference (ERS93, [A
comparison of six different ways of expressing the
bronchodilating response in asthma and COPD; reproducibility
and dependence of pre bronchodilator FEV1: E. Dompeling, C.P.
van Schayck et Al; ERJ 1992, 5, 975-981]) recommend the
following parameters:

DFEV1%pred Change of FVC as percentage of predicted value

DFEV1%poss Change of FEV1 as percentage of possible value

Methacholine and Histamine Bronchial provocation Tests 

The most common indication for performing methacholine and
histamine bronchial challenges is to diagnose hyperresponsive
airways. Some patients demonstrate normal baseline pulmonary
function despite complaints of “tightness” wheezing, cough, and
a little or not response to bronchoconstrictor. Other patients
demonstrate spirometric improvement after use of
bronchoconstrictor have diurnal variation in peak flows. In this
groups aerosolised bronchial challenges are used to confirm a
diagnosis of Asthma.

We can summarise the use of the test as follows:

1. Diagnose asthma

▲▲▲ 
Note: Read 
carefully the 
contraindications 
in Chapter 1. 
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2. Confirm a diagnosis of asthma

3. Document the severity of hyperresponsivness

4. Follow changes in hyperresponsivness

When patients with hyperresponsive airways inhale certain
pharmacologic agents (i.e. Methacholine or histamine) the
airways respond by constricting.

Test consists of executing repeated FVC following the
pharmacologic agents inhalation according to an established
protocol. The fall of the FEV1 parameter is used to calculate the
bronchial hyperresponsivness. The most important parameter is
the PD20 that is amount of drug (mg/ml) that causes a reduction
of 20% of the FEV1 respect the basal value (without drug).

Main parameters are:

P10 Dose that causes a 10% fall of FEV1.

P15 Dose that causes a 15% fall of FEV1.

P20 Dose that causes a 20% fall of FEV1.

The representative plot is the Dose/response curve, showing the
percentage variation of FEV1 versus the Drug dose in
logarithmic scale.

The program assumes as the baseline test the best FVC pre

carried out during the today’s visit. You can change the reference 
pre test editing the Post test.

The name of the drug, its quantity and its unit of measurement,
can be typed immediately before any FVC post manoeuvre
(manual protocol) or can be stored in a database of
bronchoprovocation (File/Bronchial Provocation protocols 

Database…).

Perform the test 

(During 1st step only) select Protocol... from the Test menu and
choose the name of the bronchoprovocation protocol that you are 
going to use (manual protocol if you want to type the
information about the agent before any manoeuvre) 

1. Select FVC post from the Test menu. 

2. Select an existing protocol or click on “manual protocol”,
and wait the green leds turned on.

3. Press F2, or the button by side, to start the test. 

4. Press F3, or the  button by side, to achieve the test. 
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5. In order to visualise the V/t graph and the main parameters 
press the follow buttons:

view Flow Volume graph

view data of the test

view bronchial provocation response

6. Press Alt+F3 to stop the acquisition discarding the results.

7. Repeat the test until it is correctly performed (ATS
recommends 3 times).

8. Press Exit to visualise the test list carried out during current
session together with the results of the main parameters.

9. Select the test that you want to save (the Best Test according 
to the ATS criteria is highlighted as default) and press OK. 

Bronchial Provocation protocols Database 

The response to a bronchoprovocator is usually assessed in terms
of change in the FEV1, vital capacity or airways resistance on the 
basis of serial measurements (FVC manoeuvres) in which the
results of the initial test constitute the reference values. The
international literature proposes several standardised protocols in
order to address the methodological issues of the various
available techniques.

The possibility to store a bronchoprovocation protocol in a
database is useful to simplify and automate the sequence of
operations that the Physician need to execute during the
bronchoprovocation tests.

The typical sequence of activities to carry out a
bronchoprovocation test are:

1. Typing and storing a bronchoprovocation protocol in the
database (usually only once).

2. Selection of protocol among the list of the ones already
present in the database before carrying out the FVC post
tests (the selection of “manual protocol” allows to execute
the test fully manually).

3. Performing the Post tests.
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Enter a new Bronchial provocation protocol in the archive 

1. Select Bronchoprov. protocols database  from the File 

menu.

2. Type the Protocol name, the Bronchoprovocator name and
the unit of measurement in the proper input fields.

3. If the bronchoprovocator has a cumulative effect select the
cumulative check button.

4. Enter the quantities for each step and press the button .
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Viewing results 

All the visualisation functions refer to the test carried out by the
Current Patient, whose name is indicated on the left-side of the
status bar.

To view tests results:

1. Select  the Patients from the File menu 

2. Select the patient corresponding to the test you want to view.

3. Select in the list box of the tests up to 5 tests of the kind
(FVC, VC/IVC, or MVV) and press OK.

To switch between graph and or data use the following buttons
on the toolbar:

view  Flow Volume graph (F5)

view Volume Time graph (F6)

view data of the test (F7)

view bronchial provocation response.

If you need more than one visualisation meantime use the New 

Window function from the Window menu.

If you need to display a list of visits:

• Select Visits list... from the File menu.

• Type the name of the Company and/or the time interval
desired or simply confirm for the complete list.

Tests of the current patient 

If a current patient has been selected you can quickly view his
tests selecting Test current patient... from the View menu.

Delete a test 

1. Select Patients  from the File menu  or press the button by
side.

2. Select the test that you want to eliminate from the list of the
tests referred to the Current Patient and press Delete.
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Printing results 

You can print out in three different ways:

• printing the Report

• printing the Active Window

• printing a series of reports

Printing Reports 

To print a report of the current visit, select Print report… from
File menu. The software will choose automatically the best
performed test.

The standard Report is composed by 1, 2 or 3 pages depending if 
you wish to printout the FVC data and the graphs together on the 
first page or if you wish to printout the bronchoprovocation
response.

• Selecting the option One page (no ATS) the report will
contain, on one page, the F/V and V/t graphs of the best test, 
overlapped on the FVC Post, the patient data, the notes, the
diagnosis and the test results.

• Otherwise the report will contain two pages, the first with
the patient data, the graphs and the diagnosis, and the second 
one with the measured parameters, according to the ATS
recommendations.

• The 3rd page will contain the bronchoprovocation response.
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Select the desired options:

FVC graph Prints the F/V and V/t curves for the best
FVC test.

One page (no ATS) Prints data and graphs on the first page.

Response Prints the bronchoprovocator response.

FVC post Prints data and graphs for the Post FVC test 
(the test can be selected among the test
performed in the current visit).

Preview Views a report preview on the screen.

Printing the active window 

This printout function is only enabled when the active window
(title bar highlighted) is one of the following objects:

• Any kind of Graph.

• Numeric data

• List of visit

To print the active window select Print Active window from
File menu.

Printing a series of reports 

Sometimes it is useful to printout automatically a series of reports 
(all tests carried out with the employees, all tests carried out in
the today's session).

To print out proceed as follows:

1. Select Visit List from the File menu

2. Set the criteria of the visits to be added in the list (from,
to,...)

3. Select Print Report  from the File menu.

Electronic reports (*.pdf) 

If an Adobe PDF writer “Printer Driver” is installed and set as
the default printer, it is possible to store the printout report
automatically in any location of the HD or eventually LAN paths
according to a customizable filename format.

It is possible to define the created filename format selecting
File/Page Set up... (see Page set-up).
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Export data 

With this function you can export the test data in 4 different
formats:

• *.txt (ASCII)

• *.xls (Microsoft Excel)

• *.wk1 (Lotus 123)

• *.xpo (Cosmed)

Export a test 

1. Select Export tests from the File menu.

2. Select the test to export from the list box and press OK.

3. Type the name and the format of the file in the dialog Save 

as. If  the ASCII format is selected, the Text button in the
dialog box Save as allows you to configure the separators for 
character based files. 

With the *.xpo Cosmed file format it is possible to import
data from another Quark archive. Press OK to confirm.

4. Select the folder for the export and type the file name. Press
OK to confirm. A status bar will show the file creation.
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Airway resistance 
measurement 

(option) 
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The airway resistance measurement test 

The measurement of the airway resistance is an important
determinant for the assessment of the respiratory system.
Traditional methods of measurement are based on body
plethysmography which, although highly standardised, require a
certain degree of patient’s co-operation.

In many cases (critical illness, acute asthma, geriatric and
unconscious patients, neonates, pre-school children) this is not
possible and different measuring methods are required.
Instruments based on the interrupter technique are good
alternatives to body plethysmography.

The idea behind the interrupter technique is that alveolar pressure 
will rapidly equilibrate the pressure at the mouth during a
transient airflow interruption. Thus if we provoke an airflow
interruption and measure the pressure at the mouth immediately
after the interruption, we are able to express the airway resistance 
as the ratio between the pressure at the mouth (identical to
alveolar one) and the value of the flow before the interruption.

The Appendix reports bibliographic references, which
demonstrate a high reproducibility and correlation between the
values so measured and those measured by body
plethysmography.

The measured parameters are the following:

Rocc_ex Expiratory resistance

Gocc_ex Expiratory conductance

Rocc_in Inspiratory resistance

Gocc_in Inspiratory conductance

Performing the test without the PC 

After having connected the module to the unit (see Installation

chapter):

1. Select 2.Option/8.Rocc

2. Set the test options

• Random (automatic) or manual occlusion

• Occlusion activated on the inspiration or expiration

• Value of the flow at which the occlusion is activated

• Use of COSMED antibacterial filter
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• Parameters for the back-extrapolation algorithm.

3. Select the patient

4. Select 1.Test/8.Rocc PRE or 1.Test/9.Rocc POST 

5. Wait for the end of the calibration.

6. Let the patient to breathe inside the module.

7. If manual occlusion is selected, press 1.Manual each time
you desire to activate an occlusion.

8. After each occlusion, you are asked if accept or discard the
result.

9. End the test by pressing the key by side.

10. Press the key by side to stop the acquisition discarding the
results.

Performing the test with the PC 

After having connected the module to the unit (see Installation

chapter):

1. Select Rocc from the Test menu.

2. The Test option window will open

By means of this window you can set the following options:

• Random (automatic) or manual occlusion

• Occlusion activated on the inspiration or expiration

• Value of the flow at which the occlusion is activated

• Use of COSMED antibacterial filter

• Parameters for the back-extrapolation algorithm.

3. Wait for the end of the calibration.

4. Let the patient to breathe inside the module.

5. If manual occlusion is selected, press F2 each time you
desire to activate an occlusion.

6. After each occlusion, you are asked if accept or discard the
result.
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7. End the test by pressing F3 or the button by side.

8. In order to view the graphs or the main parameters, press the 
following  buttons:

view the ROCC graph

view an average of the measured parameters

view all the performed steps
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9. Press Alt+F3 or the button by side to stop the acquisition
discarding the results.
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System 
maintenance 



108 - Pony FX User Manual 

System maintenance 

All service operations which are not specified in this user manual 
should be performed by qualified personnel in accordance with
the service handbook (to be required to the manufacturer).

All materials used in the construction of the Pony FX are non
toxic and pose no safety risk to the patient or operator.

Prior to the device cleaning, disinfection and inspection it is
necessary to switch off the device and to disconnect adapters
from the supply mains.

In order to guarantee the highest accuracy of measurements we
recommend you to disinfect the turbine periodically.

Use disposable anti-bacterial filters or disinfect each part in
contact with the patient before each test.

Cleaning and disinfection 

Cleaning and disinfecting instructions are of fundamental
importance to control infections and assure patient safety. In fact
aspiration of residue, particles and contaminated agents are life –
threatening.

In this handbook we strongly recommend you to follow the rules
worked out by ATS and ERS (see: ”Lung Volume Equipment
and Infection Control” – ERS/ATS WORKSHOP REPORT
SERIES, European Respiratory Journal 1997; 10: 1928 – 1932),
which are summarised as follows:

• Accessible internal as well as external surfaces of equipment 
exposed to expired gas should be washed and disinfected
prior to testing of subsequent patients.

• Liquid disinfection can be used if the equipment is well
cleaned first (no droplets of saliva/sputum remain).

• Disposable gloves should be worn when handling
mouthpieces, when cleaning equipment exposed to saliva or
sputum and especially when drawing blood.

• Laboratory staff should wash hands prior to testing of each
patient.

• Adopt particular precautions when testing patients with
recognised high - risk communicable diseases (e.g.
tuberculosis, multidrug - resistant staphylococcus). In these
cases, the clinical need for such testing should justify the
risks.
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During the disinfection:

• do not use alcohol or other liquids containing gluteraldehyde 
on the exterior surfaces of the equipment. Actually they can
damage polycarbonates plastics and may produce unhealthy
substances.

• do not use abrasive powders or glass cleaners containing
alcohol or ammonia on the plexiglas components of the
equipment

• do not steam autoclave any parts of the equipment unless it
is clearly specified.

• do not immerse the optoelectronic reader.

Preparing the disinfecting solution 

The following recommendations are retrieved from:

APIC (Association for Professionals in Infection Control and 

Epidemiology, Inc.): APIC Guidelines for Selection and Use of 

Disinfectants; William A. Rutala, PhD, MPH, CIC. American 

Journal of Infection Control, vol.24, N.4, pp. 313-342, August 

1996 - http://www.apic.org/pdf/gddisinf.pdf 

As disinfecting solution it is suggested:

• Sodium hypochlorite 0.5% (5000 ppm) prepared fresh for
use within 24 hours.

• Sodium hypochlorite 1% (10000 ppm) prepared fresh for use 
within 30 days.

The first solution can be easily prepared by adding 1 part
household bleach (sodium hypochlorite 5.25%) to 9 parts water,
the second one by adding 1 part household bleach to 4 parts
water.

Cleaning the turbine flowmeter 

It is necessary to disinfect periodically the turbine for sanitary
measures or/and for the correct device function.

1. Take out the turbine.

2. Dip it in a disinfectant solution (non alcoholic based) for
about 20 minutes.

3. Rinse the turbine in a vessel, filled of clean water, shaking
gently to remove the disinfectant (do not clean the turbine by
putting it under running water!).

4. Let it dry to air.

▲▲▲ 
Warning: Do not 
use alcoholic 
solutions for the 
turbine, 
otherwise there 
can be damages 
to the plastic 
material. 
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5. After cleaning the turbine, check if the turbine propeller
rotates freely even with a low speed air flow.

6. Connect the turbine to the reader.

Precautions during the cleaning of the turbine 

1. Do not expose the turbine to high heat and do not put it
under running water.

2. Do not ever dip the optoelectronic reader in any kind of
solution, the liquid infiltration would damage the internal
circuit.

3. Do not use alcoholic solutions to clean the turbine.

Suggested disinfection solutions 

Helipur H Plus Braun Melsungen AG

Gigasept FF Schulke & Mayr GmbH

Dismozon pur Bode Chemie GmbH

TETA-S Fresenius AG

CIDEX Johnson & Johnson

Inspections 

The equipment requires easy inspections to be carried out in
order to assure a proper electrical and mechanical safety level in
the years.

These inspections are highly recommended after a rough use of
the equipment or after a period of storage in unfavourable
environmental conditions.

Referring to the electrical safety, it is important to check the
conditions of insulation materials of cables, plugs and any other
visible part by means of simple inspection, when the equipment
is switched off and adapters (or electrical feeders) are
disconnected from the supply mains.

Extract the turbine from the unit and verify, by inspection, that
the turbine axis fits correctly its seats and the blade is strongly
fastened on the axis itself (it can be useful to shake slightly the
turbine in order to note any anomalous movement).

Check if there are any torn or broken components in the
breathing circuits: remember that they can create safety risk to
patients during tests.



 

Appendix 
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Service - Warranty 

Warranty and limitation of liability 

COSMED provides a one (1) year limited warranty from the date 
of the original sale of COSMED products. All COSMED
products are guaranteed to be free from defect upon shipment.
COSMED’s liability for products covered by this warranty is
limited exclusively to replacement, repair, or issuance of a credit
for the cost of a defective product, at the sole discretion of
COSMED.  COSMED shall not be liable under the foregoing
warranty unless (i) COSMED is promptly notified in writing by
Buyer upon discovery of defect; (ii) the defective product is
returned to COSMED, transportation charges prepaid by Buyer,
(iii) the defective product is received by COSMED no later than
four weeks after the last day of the one (1) year limited warranty
period; and (iv) COSMED’s examination of the defective product 
establishes, to COSMED’s exclusive satisfaction, that such defect 
was not caused by misuse, neglect, improper installation,
unauthorised repair or alteration, or accident.  If the product is
manufactured by a third-party, COSMED shall make available
for the Buyer’s benefit only those warranties which COSMED
has received from the third-party manufacturer(s). COSMED
hereby specifically disclaims any and all warranties and/or
liabilities arising from defect(s) and/or damage(s) to and/or
caused by products manufactured by third-party manufacturers.
Buyer must obtain written authorisation from COSMED prior to
the repair or alteration of COSMED products(s).  Failure of
Buyer to obtain such written authorisation shall void this
warranty.

COSMED hereby specifically disclaims any and all other
warranties of any kind, whether express or implied, in fact or by
law, including, but without limitation, any and all warranties of
merchantability and/or fitness for a particular purpose.

COSMED shall not be liable for special, indirect and/or
consequential damages, nor for damages of any kind arising from
the use of any COSMED’s products, whether said products are
used alone or in combination with other products or substances. 

Determination of the suitability of any of COSMED’s product(s)
furnished hereunder for the use contemplated by Buyer is the sole 
risk and responsibility of Buyer, and COSMED has no
responsibility in connection therewith. Buyer assumes all risks
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and liabilities for loss, damage or injury to persons or property of 
Buyer or others arising out of the use or possession of
COSMED’s products.

The limited warranty as herein above set forth shall not be
enlarged, diminished, modified or affected by, and no obligation
or liability shall arise or grow out of, the renderings of technical
advice or service by COSMED, its agents or employees in
connection with Buyer’s order or use of the product(s) furnished
hereunder.

Return goods policy for warranty or non warranty repair 

Goods shipped to COSMED for repair are subject to the
following conditions:

1. Goods may only be returned after your receipt of a Service 

Return Number (SRN) from COSMED S.r.l.

2. Place your SRN report and Packing List outside the package.

3. Goods returned must be shipped with freight and insurance
charges prepaid. Collect shipments will not be accepted.

4. The following list of goods are not eligible for return unless 
proven defective.
- Special order items
- Expendable products
- Goods held over 30 days from COSMED’s invoice date.
- Used goods not in original shipping containers.
- Goods which have been altered or abused in any way.

5. The following parts are not covered by warranty:
- consumables
- fragile glass or plastic parts
- rechargeable batteries
- damages due to use of the device not conforming to the 
indication reported in this manual 

Repair Service Policy 

Goods returned to seller for Non-Warranty repair will be subject
to conditions 1, 2, 3, 4.

The returned goods need to re-enter COSMED together with the
customs documents (Pro-forma Invoice and Customs Paper) as
requested by the Italian law.

• The shipment has to be qualified as a Temporary Export.
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• All the goods returned to COSMED without the customs
papers will not be accepted. 

For European Community members: 

Pro-Forma invoice complete with:

• Number

• Description of the goods

• Quantity

• Serial Number

• Value in €

• Number of parcel

• Gross weight

• Net weight

• Reason for resent (i.e. Resent for repair)

In case you should send the system for repair please contact the
nearest service centre or contact COSMED at the following
address:

COSMED S.r.l. 

Via dei Piani di Monte Savello 37
P.O. Box 3
00040 Pavona di Albano - Rome, Italy
tel. +39 (06) 9315492
fax +39 (06) 9314580
E-mail: customersupport@cosmed.it

For USA customers only please contact: 

COSMED USA Inc 

2758 North Paulina
Chicago IL 60614 USA
Phone: +1 (773) 528-8113
Fax: +1 (773) 528-8116
email: usa.sales@cosmed.it

To ensure that you receive efficient technical assistance, please
specify as precisely as possible the nature of the problem as it is
specified on the assistance information form.

We advise you to save the original packaging. You may need it in 
case to ship the unit to a technical assistance centre.
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Privacy Information 

Dear Customer,

we inform you that your personal data are gathered and will be
used by Cosmed Srl in conformity with the requirements of the
Italian privacy law (Decreto Legislativo 196/2003). We believe it 
is important for you to know how we treat your personal data.

Personal data treatment and purposes 

We request and process your personal data:

a. to place an order, register a product, request a service,
answer a survey, enter a contest, correspond with us (all of
the above, in the following: “service”) and, if necessary, to
supply the Competent Authorities with the required
information;

b. in order to define your commercial profile;

c. in order to use your commercial profile for own marketing
and advertising purposes;

d. for accounting purposes, including e-mailing of commercial
invoices;

e. for providing your information to selected business partners
(also abroad), in order to supply the service;

How your personal data are treated 

Your personal data will be stored in electronic format, and
protected at the best from destruction, loss (even accidental), not
authorized accesses, not allowed treatment or use not in
conformity with the purposes above listed.

The consent is optional, but… 

If you deny the consent, we regret we cannot supply the service.

Holder of the treatment 

The holder of the treatment is Cosmed Srl, Via dei Piani di
Monte Savello 37, Pavona di Albano Laziale (RM). The
responsible of the personal data treatment is indicated in the
documentation stored by Cosmed Srl itself.
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Customer rights 

In accordance with art.7 of the Law, you can:

a. obtain confirmation of the existence of your personal data
and their communication in intelligible form;

b. obtain:

• updating, correction or integration of your data;

• deletion or transformation in anonymous form of your
personal data;

c. deny your consent to the treatment of your personal data;

These rights can be exercised directly requesting in writing to the 
holder of the treatment.



 Chapter 10 - Appendix - 117 

Converting factors configuration 

You can edit the parameters shown in Control Panel by selecting
Control Panel from the Calibration menu in the calibration
program, then pressing the button by side.

You might configure the following options:

Name: identify the parameter

Unit of meas.: unit of measurement

Base line and Gain: factors used to convert the acquired raw
data (mV) into the final format according to
Y=(mV-BL)*Gain. The value entered for
gain must be multiplied by 1000 (for
Gain=1, enter 1000).

Precision: the number of decimals shown as 0 
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ATS 94 recommendations 

Reference: “Standardization of Spirometry: 1994 Update”
“American J. Respiratory Critical Care Medicine”, Vol. 152,
1107-1136; 1995.

ATS recommendations 

Volume range: 8l (BTPS)

Flow range: ±14 l/sec

Volume accuracy: ±3% or < 50ml

Flow accuracy: ±5% or < 200ml/sec

Flowmeter resistance: <1.5 cmH2O da 0 a 14 l/sec

Reproducibility: the 2 largest of 3 acceptable FEV1 and FVC
values should be within 5% or 150 ml.

The end of test: no change in volume for 1 second with at least 6 
seconds of collected volume.

Accumulation time: the maximum time allowed for volume
accumulation during the VC manoeuvre should be at least 30
seconds and at least 15 seconds during the FVC.

The spirometer should be store at least 8 FVC maneuvres.

FEV1 should be calculated by using the “back extrapolation”
method to detect the start of the test, extrapolated volume must
not be higher then 5% FVC or 150ml.

The graphic resolution of the printed report must be as in the
following:

Volume: 10 mm/l

Flow: 5 mm/l/sec

Time: 20 mm/sec

F/V ratio: 2:1

The total number of error (FVC e FEV1 >±3.5%, FEF25-75%
>5.5%) during the measurement of the 24 standard  waveforms
must be lower than 4.
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Predicted values 

ERS93 

Standardized Lung Function Testing: Official Statement of the
European Respiratory Society, The European Respiratory Journal 
Volume 6, Supplement 16, March 1993.

Compilation of reference values for lung function measurements
in children: Ph. H. Quanjer, J. Stocks, G.Polgar, M. Wise, J.
Karlberg, G. Borsboom; ERJ 1989, 2, Supp.4,184s-261s.

KNUDSON 83 

Changes in the Normal Maximal Expiratory Flow-Volume Curve 
with Growth and Anging: J. Knudson, D. Lebowitz, J. Holdberg,
B. Burrows; ARRD 1983; 127:725-734

ITS 

Intermountain Thoracic Society: Clinical Pulmonary Function
Testing, second edition (1984) pp 101, 144

LAM 

A survey of ventilatory capacity in Chinese subjects in Hong
Kong: Lam Kwok-Kwong, Pang Shing et Al. Annals of Human
Biology, 1982, vol. 9, No. 5, 459-472.

Multicéntrico de Barcelona 

Spirometric reference values from a Mediterranean population: J. 
Roca, J. Sanchis, A. Agusti-Vidal, F. Segarra, D. Navajas. R.
Rodriguez-Roisin, P. Casan, S. Sans. Bull. Eur. Physiopathol.
Respir. 1986, 22, 217-224.

Nhanes III 

Spirometric reference values from a sample of the general US
population: John L. Hankinson, John. R. Odencrantz and
Kathleen B. Fedan. Am J Respir Critr Care Med 1999, 159,
1798-187.

Pneumobil (Brazil) 

Valores extraìdos do Programa Pneumobil/Brasil para a Tese de 
Doutoramento do Dr. Carlos Alberto de Castro Pereira.
(Boehringer).

Gutierrez (Chile) 

Gutierrez et Al. Reference values for Chile population

Knudson, Morris and Bass 

The maximal Expiratory Flow-Volume curve: Knudson et al.
ARRD Vol. 123, p. 659-664, 1981
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Spirometric Standard for healthy non-smoking adults: ARRD
Vol. 10-3, p. 57-67, 1971

Pereira (Brazil) 

Pereira CAC; Barreto SP; Simões JG; Pereira FWL; Gerstler JG; 
Nakatani J. Valores de Referência para Espirometria em uma
amostra da população brasileira adulta. Jornal de  Pneumologia
1992; 18: 10-22.

Mallozi MC. Valores de referência para espirometria em crianças 
e adolescentes, calculados a partir de uma amostra da cidade de
São Paulo. Valores finais publicados em : Pereira CAC; Lemle
A; Algranti E; Jansen JM; Valença LM; Nery LE;  Mallozi M;
Gerbasi M; Dias RM; Zim W. I Consenso Brasileiro sobre
Espirometria. Jornal de Pneumologia 1996; 22:105-164.

Scalambrini Costa F, Scueiri CEB, Silva Jr WC, Pereira CAC,
Nakatani J. Valores de referência para espirometria em uma
amostra da população brasileira adulta da raça negra. J
Pneumologia 1996;22: 165-170.

Neder JA; Andreoni S; Castelo-Filho A; Nery LE. Reference
values for lung function tests. I. Static Volumes. Brazilian
Journal Medical and Biological Research 1999; 32:703-17.

Neder JA, Andreoni S, Lerario MC, Nery LE. Reference values
for lung function tests. II. Maximal respiratory pressures and
voluntary ventilation. Braz J Med Biol Res 1999 ;32:719-27

DLCO 

Standardized Lung Function Testing: Official Statement of the
European Respiratory Society, The European Respiratory Journal 
Volume 6, Supplement 16, March 1993.

Compilation of reference values for lung function measurements
in children: Ph. H. Quanjer, J. Stocks, G.Polgar, M. Wise, J.
Karlberg, G. Borsboom; ERJ 1989, 2, Supp.4,184s-261s.

Reference Values for Residual Volume, Functional Residual
Capacity and Total Lung Capacity - ATS workshop on Lung
Volume measurements, official statement of the European
Respiratory Society; J. Stocks, Ph. H. Quanjer: ERJ, 1995, 8,
492-506

Single Breath Oxygen Test 

Buist SA, Ross BB: Quantitative Analysis of the Alveolar
Plateau in the Diagnosis of Early Airway Obstruction. ARRD
108: 1081, 1973

Mansell A, Bryan C, Levison H: Airway Closure in Children.
JAP 33: 711-714, 1972
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Buist SA, Ross BB: Predicted Values for Closing Volumes Using 
a Modified Single Breath Test. ARRD 107: 744-751, 1973.

Rint 

Lombardi E, Sly PD, Concutelli G, et al. Reference values of
interrupter respiratory resistance in healthy preschool white
children. Thorax 2001; 56: 691-695.

Mip/Mep 

Leo F. Black, Robert E. Hyatt: Maximal Respiratory Pressures:
Normal Values and Relationship to Age and Sex, American
Review of Respiratory Disease, Volume 99, 1969

Vincken W, Ghezzo H & Cosio MG (1987). Maximal static
respiratory pressures in adults: normal values and their
relationship to determinants of respiratory function. Bull Eur
Physiopathol Resp 23: 435-439.

Automatic interpretation (algorithm) 

Reference: “Lung Function Testing: selection of reference
values and interpretative strategies”, A.R.R.D., 144/ 1991:1202-
1218.

LLN=Pred-0.674*SD (ATS, 50° percentile)

LLN=Pred-1.647*SD (ERS, 95° percentile)

LLN=Pred*0.8 (80%Pred)

Note: This interpretation is only a suggestion that must be 

supported by clinical judgement. 

Message interpretation Criterion 

Normal Spirometry FVC and FEV1/FVC > LLN

Obstructive abnormality
(it may be physiological) % Pred FEV1 >= 100 

Obstructive abn.: mild % Pred FEV1 < 100 and >= 70

Obstructive abn.: moderate % Pred FEV1 < 70 and >= 60

Obstructive abn.: mod. severe % Pred FEV1 < 60 and >= 50

Obstructive abn.: severe % Pred FEV1 < 50 and >= 34

Obstructive abn.: very severe % Pred FEV1 < 34

Restrictive abn.: mild FVC<LLN and %Pred FVC>=70

Restrictive abn.: moderate % Pred FVC < 70 and >= 60

Restrictive abn.: mod. severe % Pred FVC < 60 and >= 50
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Restrictive abn.: severe % Pred FVC < 50 and >= 34

Restrictive abn.: very severe % Pred FVC < 34

Quality Control Messages 

Reference: Spirometry in the Lung Health Study: Methods and
Quality Control, ARRD 1991; 143:1215-1223.

Message Criterion 

Start faster VEXT >5% of the FVC and >150ml

Blast out harder PEFT >120 msec

Avoid coughing 50% drop in the flow in first second

Blow out longer FET100% <6 sec.

Blow out more air flow >0.2l/s within 20 ml of FVC

Blow out harder dPEF<10%

Take a deeper breath dFVC<200ml and 5% best FVC

Blow out faster dFEV1<200ml and 5% FEV1

That was a good test No errors

FVC reproducible diff. 2 max FVC within 0.2 l

FEV1 reproducible diff. 2 max FEV1 within 0.2 l

PEF reproducible diff. 2 max PEF within 10 %

MVV time too short MVV time less than 12 sec
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References 
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 cosmed.com

PRODUCT GUIDE
Antiviral/Antibacterial Filters

The Most Effective, Safe and Affordable Solution to Prevent Viral and 
Bacterial Cross-Contamination

 f High viral and bacterial filtration 
efficiency (99.999%)

 f Low resistance to airflow
 f Suitable for both lung function and 

exercise testing
 f Minimal deadspace
 f Available with both round and oval/

ergonomic mouthpiece shape
 f Individually packaged in 50 pieces 

box 

COSMED antiviral and antibacterial respiratory filters provide an easy way 
to ensure protection from cross-contamination which keeps both the pa-
tient and operator safe without compromising on system performance. 
The use of filter during lung function and metabolic testing also reduce 
the amount of droplets aerosol dispersion in the air mitigating the con-
tamination of the environment due to forced expirations and high ventila-
tions required during testing. Preventing aerosol spreading is fundamental to 
minimize infection diseases transmissionGFE.
The resistance of the combined system necessary to perform the tests is in-
ferior to those suggested by the ATS/ERS (1.5cmH2O/L/sec@14 L/sec)D both 
during inhalation and exhalation.
COSMED filters are tested by independent laboratories passing BFE and 
VFE test using Staphylococcus Aureus (*ATCC #6538) and Bacteriophage 
PHI X174 (dimension about 0.025 µm). According to current knowledge 
Coronavirus species, including COVID-19 have a particle size of 0.06-0.2 
µm, which is significantly larger than the bacteriophages used in the ef-
fectiveness tests. However, at this point in time we have not conducted 
any specific tests against COVID-19 as the challenge organism.
COSMED filters comply with latest ERS guidelines recommending to use  
the filters with minimum proven efficiency for high expiratory flow of 600 
to 700 L/minE.
Two mouthpiece types, oval and round, guarantee the maximum ergo-
nomics and the compatibility with any equipment connector.



Technical Specifications
Mouthpiece Shape

Product Patient Hlter - Oval mouthpiece Patient Hlter - Round mouthpiece

Part number A 182 300 005 A 182 300 004

Dimensions Machine side: OD 30.7mm,  ID 26mm 
Patient side: Integrated mouthpiece  
Length: 86mm 
Width: 97mm

Machine side: OD 30.7mm,  ID 26mm 
Patient side: OD 24.9mm, ID 20.9mm 
Length: 77mm 
Width: 97mm

Material Housing: Polypropylene

Filter Media: 200g electrostatic blended synthetic Hbre

Packaging Box of 50 Hlters individually packed in single plastic bags

Pathogenous agents Bacteria and virus

Bacterial Hltration 
eGciency*

99.999% 
(Staphylococcus aureus @ 30L/min)

Viral Hltration 
eGciency*

99.999% 

(Bacteriophage @ 30L/min)

Resistance 
(EN ISO 9360-1)

0.27cmH2O @ 30L/min

0.59cmH2O @60L/min

0.97cmH2O @ 90L/min

0.39cmH2O @ 30L/min

0.74cmH2O @60L/min

1.1cmH2O @ 90L/min

 Dead space 75ml

Applications Pulmonary function test

Spirometry

Cardio pulmonary exercise test

(with adapter C05085-01-20)

Indirect calorimetry

© 2020/06-a     COSMED     E & OE. Subject to alterations without prior notice.     REF. C02581-02-93

COSMED Srl

Via dei Piani di Monte Savello 37 
Albano Laziale - Rome 00041, Italy

+39 (06) 931-5492 Phone 
+39 (06) 931-4580 Fax

info@cosmed.com | cosmed.com

* The signiHcance of % Hltration eGciency is explained by the number 
of organisms passing through the Hlter. If the number of organisms 
challenging the Hlter are 1 000 000, when the eGciency is 99.999% only 
10 organisms pass through (or only 1 if the eGciency is 99.9999%). A 
99.999% Hlter is therefore 10 times more eGcient than 99.99% Hlter. 

References:

(1) ERS COVID-19 resource centre (https://www.ersnet.org/the-society/
news/novel-coronavirus-outbreak--update-and-information-for-
healthcare-professionals); Novel Coronavirus (COVID-19): The ATS 
Response (https://www.thoracic.org/professionals/clinical-resources/
disease-related-resources/novel-coronavirus.php) 

(2) Recommendation from ERS Group 9.1 (Respiratory 
function technologists/Scientists) Lung function testing during 
COVID-19 pandemic and beyond (https://ers.app.box.com/s/
zs1uu88wy51monr0ewd990itoz4tsn2h)

(3) “STANDARDISATION OF LUNG FUNCTION TESTING”  Edited by V. 
Brusasco, R.Crapo and G. Viegi: Standardisation of spirometry, Eur Respir 
J 2005; 26: 319–338

COSMED filters have been tested to be 
used during Cardio Pulmonary Exercise 
Testing.
The following chart provides results of 
resistance to air flow at different ventila-
tion rates up to 200 L/min that represent 
ventilation rates reached by high-level 
athletes.
The validation protocol compares the re-
sults against a conventional mixing cham-
ber metabolic cart and ATS/ERS maximal 
acceptable resistance for lung function 
testing equipment.
The new setups show good results for 
both expiratory and inspiratory resist-
ance when using masks with or without 
inspiratory valves.
The additional dead space introduced by 
the new setups, does not affect VOC or VCOC 
calculation.

A-182-300-004
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